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1 Introduction to Wavestore Version 6

Welcome toWavestore Version 6, the latest generation of the award-winning VideoManagement Soft-
ware.

This document provides details ofwhat’s new in each newversion 6 software release aswell as impor-
tant considerations for upgrading from earlier releases. Newest releases are listed first.

If upgrading fromanearlier version6 release, it is strongly recommended to readsection34.3 -Consid-
erations for Upgrade From Earlier Wavestore V6 Releases as well as the sections for each intermediate
release. For example if upgrading from v6.2 to v6.6, read the sections on versions 6.4 and 6.6.

Detailsofhowtoupgradefromanearlierversion6releaseare indetailed insection35-UpgradeProcess.

If upgrading from version 5, any extra considerations are detailed in section 34.4 - Considerations for
Migrating FromWavestore V5.
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2 Version 6.46 Changes

IMPORTANT:Onceaserverhasbeenupgraded to thisversion, it canonlybedowngradedas far asv6.34.
If there is a need to revert to an even older version, it is necessary to perform a fresh installation of that
version. Please readsection34.2 -ConsiderationsForUpgradeFromV6.32AndEarlier toV6.34OrLater
formore details.

2.1 Server Changes
• Improvements to handling of unsupported hardwarewith relation to disk ordering

• Added amechanism to allow numeric codes in SNMP traps for customevents

• Improvements to ’clear-tmp’ command

• Changes to downgrademechanism - no longer downgrades kernel and boot files

• Improvements to ’Shutdown by user’ message, now stateswhich user

• Newoption to allow disabling camera reboot via Onvif

• Improved handling of analytics data fromDahua cameras

• Added support for newVCA colour protocol

• Added newpassword syncmechanism to prevent false positiveswhen checking for desynchro-
nised passwords across server group

• Added newEvent Cause for ’F AnalyticsN: Analytics from camera N failed to stream’

• Improved dynamic listmanagement to allowmatching againstmetadatawithin XML

• Improvedmetadata logging and camera compatibility

• ”streams all” command now shows bit rate of all active cameras

• Cameras configured inMaintenanceMode no longer trigger Video Loss events or other Faults

• Added support for ”Bus” vehicle type in analytics

• Improvements to handling of Local User accounts

• Fixed issuewhere Standby Failover servermight not take over

• Fixed issuewhere a camerawith audio could drop framerate to 1 image per second

• Some fixes relating to object colour search

• Fixed issuewhere analytics streamingwould not attempt reconnect if initial connection fails
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• Many other fixes, improvements, andmore hardware supported

2.2 WaveView Changes
• Various improvements to recently revampedMaps system including:

– NewMap Zones to allowing switching betweenMap Areas

– New Alarm Zones - any Event Cause and its parameters can be assigned to a configurable
zonewhichwill highlightwhen triggered

– Newability to use customcamera icon

– Improvements toMaps setup screen to showprogresswhen loadingor convertingold con-
figuration

– When configuringMaps, cameraswhich have already been added are highlighted

– Side panel can nowbe hidden

– Fixed issuewith order ofMap Areas in drop-down list

• Support for analytics results containingmultiple colours per object segment andmultiple classes
per object

• Support for new analytics subtype of ’Bus’

• Improved password synchronisation for users in server group

• Added a Refresh button for ReviewStationmode to allow scanning for LASS disks again

• WhenconfiguringSNMPTrapsasaneventaction, defaultparametersarenow0toavoidoverriding
the SNMPTrap parameters

• When removing an email address recipient, event rules are now automatically updated to ensure
correct recipient list

• Fixed issueswith exportswhen using LASSReviewStation

• Fixed issuewith LASSReviewStationwhere it wasn’t possible to open a disk a second time

• Fixed issuewhere changing passwordmultiple timeswould complain that the existing password
is incorrect

• Fixed issuewith ’Smart Search > Play Multiple’ whichwould use a single camera layout instead of
2x2

• Fixed issuewith ”ShowCameras” Client Actionwhich occurred in v6.44

• Fixed issuewhere Smart Search of less than aminutewould notwork

• Fixed some issueswith synchronisation ofmetadata, particularlywhen launching clip from event

• Fixed some handling of offline servers in Setup screens

• Fixed issuewithMetadata Visualisations in saved layouts

• Many other improvements and bug fixes
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3 Version 6.44.49 Changes

IMPORTANT: Once a server has been upgraded to this version, it cannot be downgraded. If there is a
need to revert to an older version, it is necessary to perform a fresh installation of that version. Please
read section 34.2 - Considerations For Upgrade From V6.32 And Earlier to V6.34 Or Later for more de-
tails.

3.1 Server Changes
• Improved timestamp handlingwhen video + audio

• Fixedminor downgrade issuewhere a non-required packagewasn’t removed

3.2 WaveView Changes
• Fixed issuewith changing scale of cameras and event items on newMaps setup screen
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4 Version 6.44 Changes

IMPORTANT:Onceaserverhasbeenupgraded to thisversion, it canonlybedowngradedas far asv6.34.
If there is a need to revert to an even older version, it is necessary to perform a fresh installation of that
version. Please readsection34.2 -ConsiderationsForUpgradeFromV6.32AndEarlier toV6.34OrLater
formore details.

4.1 Server Changes
• Improvements toMachine ID handling onWavestore-as-an-Application

• Improved support for ONVIFMetadata includingObject Detection and LPR data

• Added support for event rule textmatch referring to a list provided in a file

• Addedsupport forLineCrossingDetectionandLoiteringDetectionevents forHoneywellHC35WB5R2,
HC35WB8R3 andHC35WE5R3 cameras

• Improvements to integration interfaces (allowinguseofPOST insteadofGETwhen interfacingvia
HTTP)

• Improved speed of restart and reboot

• Fixed some issueswith Vivotek camera integration

• Fixed issuewith https tunnelling for Dahua cameras

• Fixed issue with password storage for local users which could cause unnecessary configuration
conflicts in server groups

• Fixed streaming issue seenwith somemulti-lens cameras

• Fixed issuewith Recording and Bounds commands of HTTPSSimple Interface

• Fixed some issueswith non-ASCII characters in file handling and incoming events

• Allowed admin-level users to re-incorporate disks in RAID arrays

• Fixed issuewith restarting cameras after firmware upgrade

• Fixed issuewith Subjectwhen event rule configured to send text email

• Fixed configuration changing issuewith HyperRAIDS1,1 arrays (2 drives, one spun down)

• Various other improvements and fixes
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4.2 WaveView Changes
• All newMap system supporting all features of legacyMap system, plus...

– Support for SVG vector graphics formats so that detail is preserved evenwhen zoomed in

– Live camera thumbnails when hovering over cameras

– Cameras opened in Display Area are highlighted onMap

– Eventmap items can now react to any Event Cause

• Metadata Search feature now available inmain screen Smart Search tool

• Device Tree filter improvements - filter now applies to servers aswell as cameras, and servers are
preserved if a child cameramatches

• New ”Expand All / Collapse All” button in Find screen

• Ability to create event rule textmatch referring to a list provided in a file

• New LASSReviewStation functionality to allow direct playback of server storage disks

• Fixed issue where playback time not preserved when switching camera when playback is on a
track other than track 1

• Fixed issuewithMJPEG export

• Improved performance in Users setup screen

• Fixed issueseenwhenusingnon-ASCIIcharacters inDiagnosticDownloadandStatusSummary
CSV export

• Fixed issue where associated camera playback information for events would not always handle
”live”mode

• Fixed issuewheremetadatavisualisationoverlaywouldn’tupdateasexpectedwhenopeningevents
from Live Event Stream

• Other general performance improvements and fixes
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5 Version 6.42 Changes

IMPORTANT:Onceaserverhasbeenupgraded to thisversion, it canonlybedowngradedas far asv6.34.
If there is a need to revert to an even older version, it is necessary to perform a fresh installation of that
version. Please readsection34.2 -ConsiderationsForUpgradeFromV6.32AndEarlier toV6.34OrLater
formore details.

5.1 Server Changes
• Significant update of base Linux operating system

• Updated NVIDIA drivers forWavestore OS

• Added support for Broadcom9600-16i HBA

• Extended Simple HTTP interface to supportmetadata

• Added support for newV-Serieswith AIC-12G-2U12SAS35EOB enclosure

• Added support for upgrading camera firmware fromWavestore

• AddedWavestore camera firmware toWavestore OS to allow upgrade

• AddedONVIF UserManagement ofWavestore

• Added Simple interface Backup/Download, and HTTPS to access simple interface

• Upgrade is now restricted to install user

• Ensured Setup > Disk > Add SwappedDisks isworking for admin-level users aswell as install

• Various improvements to Auto-Format

• Improvements for slowHBA cards on power on

• Improved support for Vivotek cameras

• Improved handling of VCA andONVIF analytics functions

• Improvements to interface to HealthMonitor after theWavestorewas offline

• Improved algorithm to determine if we need to reboot a camera

• ImprovedONVIF conformancewhen using HTTPS

• Multi-sensorWavestore cameraWV-20M4-28V8 dual streaming fixes

• Fixed issuewhere Eaton UPS integrationwould always performUPS checks even if not enabled
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• Fixed issue in Eventswhere UTF-8Characterwas not been parsed or displayed correctly

• Fixed a confusing message saying ”HyperRAID rebuild complete” when other disks had not yet
finished rebuild

• Fixed snippet for ASUS P12R-E X-Seriesmotherboardwith SMC-SC846-P enclosure

• Fixed issuewhere Network Upgrade could fail on disk space

• Fixed issuewith kernel versions after upgrading from6.32 and then downgrading

• Fixes to authentication stream for large numbers of cameras

• Additional robustness code in LASS

• Minor improvements to gateway proxy

• Fixed occasional unexepected RTSP timeout

5.2 WaveView Changes
• Added ’Load Layout at Login’ option for all available Video Display Areas

• Improved behaviour of double-click leftmouse button in Video Display Area - nowputs cameras
into and out of solomode

• Added integrationwith 3dConnexion SpaceMouse

• Added support for ”break configuration lock”mechanism

• Improved tooltips in Users setup screen

• Fixed issuewith lower than expected resolution for dewarped views

• Fixed issuewhere PTZ joystickwould notworkwhenwindownot in focus

• Fixed issuewhere ”Preserve install user” optionwouldn’t workwhen restoring default config

• Fixed issuewhere usingCtrl key to temporarily unlock layoutwould no longerwork

• Fixed issue where Channel Group Tree View option would not be remembered after application
restart

• Fixed issuewhere ”Extra Logs” window could show logs from incorrect server in server group

• Fixed issuewhere LDAP user could be prompted for password change

• Fixed issuewhere Events filterwouldn’t work correctly for Video Loss events

• Fixed shape of ”Stop layout sequence” button

• Fixed behaviour of Diagnostics Download for admin level users

• Fixed behaviour of Storage setup screen for admin level users

• Fixed issuewith un-solo-ing camera after solo-ing then switching camera, e.g. with a HotSpot

• Fixed issuewith Digital PTZ on export

• Fixed issuewhere playback ”jump to time” would use incorrect timezonewhen timezone prefer-
ence set to ”Client”
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• Fixed issuewhere ”Changepassword”popupcouldbebehind theWaveViewwindowonfirstboot

• Fixed crashwhen using ”Use position” option of Snapshot subtitles

• Various other fixes and improvements

5.3 WaveSDK ActiveX SDK Changes
• IMPORTANT:WaveSDK-ActiveX is now64-bit only

• Fairly major changes to video rendering, which should be transparent to users but may improve
performance

• Event Causes are now strings, allowing customevent causes
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6 Version 6.40 Changes

IMPORTANT:Onceaserverhasbeenupgraded to thisversion, it canonlybedowngradedas far asv6.34.
If there is a need to revert to an even older version, it is necessary to perform a fresh installation of that
version. Please readsection34.2 -ConsiderationsForUpgradeFromV6.32AndEarlier toV6.34OrLater
formore details.

6.1 Server Changes
• Improvements to firmware upload for HBA devices, to allow forcing older version if desired

• Improvements to integrationwith healthmonitor system

• Addedmechanism for performing export over HTTPS

• Extended simple HTTP interface to support HTTPS

• Added support for local users (only on this server, rather than the server group)

• Camera status reporting improvements

• Added support for new2024A-Series server hardware

• Improvements to logging of HyperRAID rebuild

• Wavestore-as-an-Application now supports emailing video clips on event

• NewHTTPS proxymechanism for accessing cameras via server

• Newgateway proxymechanism for accessing cameras via server

• Camerametadata capabilities now automatically detected and enabled

• NewCameraMaintenancemode to prevent fault reporting for cameras known to be faulty

• Fixed issuewith event statewhen changing event rules for that event

• Fixed issuewith progress reporting of network upgrades

• Fixed issuewith poor audio qualitywhen dual or triple streaming video from camera

• Fixed issuewith auto-formatting single disk volumes

• Various other fixes and improvements
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6.2 WaveView Changes
• IMPORTANT: Note thatWaveView is no longer available in a 32-bit variant. It is now64-bit only.

• Major revamp of Users setup screen, including

– Added support for local users (only on one server, rather than the server group)

– Added support for newONVIF login permission

– Added support for newSystem Log viewing permission

– Added newuser permission for accessingConnections screen

– Improvements to logic when admin users are configuring other admin users, to only allow
suitable permissions

• Camera status now shown in Cameras setup screen

• Channel Groups setup screen nowhas a ”collapse all” button

• Channel Groups setup screen now allows dragging and dropping and reordering of cameras

• Added newoption to CameraGroup for newgateway proxy feature, under ”Advanced”

• Launching cameraweb page uses newgateway proxy if enabled for camera group

• Better feedback inmainscreenwhenGroupTreeviewoption isselectedbutnogroupsconfigured

• Addedmechanism to allowVideo Display Toolbar panels to be re-enabled if all have been hidden

• Added option to enable CameraMaintenancemode per camera in Cameras setup screen

• Fixed several crashes that could occurwhen one ormore serverswithin server group offline

• Fixed issuewith video scalingwhen doing transcoded export

• Fixed issuewith smart search UIwhen in non-English language

• Fixed issuewhere video streaming could freezewhen enabling talkback onWindows
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7 Version 6.38.23 Changes

Note: This is aminor update to the v6.38 release. See 8 - Version 6.38Changes for full details of v6.38.

IMPORTANT: Once a server has been upgraded to this version, it cannot be downgraded. If there is a
need to revert to an older version, it is necessary to perform a fresh installation of that version. Please
read section 34.2 - Considerations For Upgrade From V6.32 And Earlier to V6.34 Or Later for more de-
tails.

7.1 Server Changes
• Added support for Asus Xonar audio card

• Updated firmware forMegaRAID cards

• Fixed issuewhere systemmanagement port could show as an available network port

• Fixed ocassional issuewith reformatting iSCSI devices

• Fixed potential sensor alarmwith Intel Comet LakeCPUs

• Fixed issuewith Talkback to analogue audio outputs
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8 Version 6.38 Changes

IMPORTANT:Onceaserverhasbeenupgraded to thisversion, it canonlybedowngradedas far asv6.34.
If there is a need to revert to an even older version, it is necessary to perform a fresh installation of that
version. Please readsection34.2 -ConsiderationsForUpgradeFromV6.32AndEarlier toV6.34OrLater
formore details.

8.1 Server Changes
• Support for network updates

• Camera streaming and compatibility improvements

• OS updates

• Improvements to licensing of EMS cameras

• ONVIF TLS Add-On support

• ONVIF Spherical Space and other PTZ improvements

• Talkback improvements

• Fixed issuewhere Active Directory / LDAP didn’t work correctly (issuewas in v6.34 and v6.36).

• Fixed issue where Machine ID could change when using non-default [Listen] port (issue was in
v6.36).

8.2 WaveView Changes
• IMPORTANT: Note thatWaveView is no longer available in a 32-bit variant. It is now64-bit only.

• Revamped ”Server Statistics” screen with improved performance, units shown for each graph,
”friendly” description for each statistic

• Support for network updates

• UI Updates

• Improvements to licensing of EMS cameras

• Fixes forMap camera status updates
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9 Version 6.36 Changes

IMPORTANT:Onceaserverhasbeenupgraded to thisversion, it canonlybedowngradedas far asv6.34.
If there is a need to revert to an even older version, it is necessary to perform a fresh installation of that
version. Please readsection34.2 -ConsiderationsForUpgradeFromV6.32AndEarlier toV6.34OrLater
formore details.

9.1 Server Changes
• Support for new ”Updates until” licensingmodel

• Updated baseOperating Systempackages to latest

• Now allows BMP andGIFmap images

• Several improvements to HTTP-Out Device I/O interface

• Nowautomatically attempts to resolve corrupt packagedatabasewhenupgrading to improve re-
silience

• Improvements and fixes forWavestore-as-an-Application

• New logging for slow diskwrites

• Improved handling of client Hot-Spot configuration so events are available immediately

• Added support for subscription licensing

• Better logging of ”ustart”, ”ustop”, ”server-and-client”, ”server-only” EXEC commands

• Fixed some issueswith reliability of analyticsmetadata streaming

• Fixed issuewith NVME systemdiskwith data partition

• Fixed disk slot numbering for various recent Perc/MegaRAID RAID cards

• Fixed some error handling relating toMegaRAID andHyperRAID

• Fixed issuewhere server could not be used as an NTP source

• Fixed some edge caseswith NTP synchronisation

• Fixed some edge caseswith audio timestamps upon capture

• Fixed issue upgrading from ”server-only” installation
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9.2 WaveView Changes
• Cloning videodisplays is now limited to fisheye cameras since somevideo configurations are cur-
rently not supported for cloning - this restrictionmay be lifted in future

• Hot-Spots can nowbe used to trigger Event Rules

• Improvements to Client Actions:

– Allowing popping up and closing relevant cameras upon event

– Client action condition: list of users (e.g. User=Alex,Chris)

– Client Actions setup should be group-wide

• Main screen ”Events” control nowupdates current event state and no longer truncates names

• Improvements to validation of customEvent Cause names

• FileManager nowwarns if attempting to upload files over 2GB

• ServerMaintenancewindownow allows choosing options by double-clicking

• Configuration parser performance improvement leading to faster logins and overall performance
boost

• Configuration editor now remembers last path

• Addedmechanism to handle locked recording regionswith no associated annotations

• Added support for new server ”Updates until:” licence handling

• Ensured support for PNG andGIF images inMaps

• Ensured thatWMV exports useWMA audio format

• Fixed issuewith uploadingmap imageswith special characters in the file name

• Fixed issuewith reporting camera Video Loss onMapswhen usingmultiple servers in a group

• Fixed issuewith install single package through Upgrade screen

• Fixed potential crash in System Log viewer

• Fixed issuewith ConfigurationConflict Resolution tool forMaps

• Fixed issuewith ”FindMetadata” clip bounds being incorrect

• Fixed issuewhere event rules configured on very old softwarewith ”Showonmain screen” option
would not show

• Fixed issuewith Event Rules configuredwith AND, OR and XOR operators

• Fixed issuewith encoding authentication credentials for VAPIX I/O devices

• ManyOtherminor fixes and improvements
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10 Version 6.34.155 Changes

IMPORTANT: Once a server has been upgraded to this version, it cannot be downgraded. If there is a
need to revert to an older version, it is necessary to perform a fresh installation of that version. Please
read section 34.2 - Considerations For Upgrade From V6.32 And Earlier to V6.34 Or Later for more de-
tails.

10.1 Server Changes
• Fixed issuewith NFS storage

• Fixed issuewhere some disk drivers could be removed after upgrade

10.2 WaveView Changes
• Fixed issuewhere Video Loss status of cameras onMaps could be incorrect
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11 Version 6.34 Changes

IMPORTANT: Once a server has been upgraded to this version, it cannot be downgraded. If there is a
need to revert to an older version, it is necessary to perform a fresh installation of that version. Please
read section 34.2 - Considerations For Upgrade From V6.32 And Earlier to V6.34 Or Later for more de-
tails.

11.1 Server Changes
• Major operating systemupdate

• New analytics segment colour search (e.g. red torso, blue lower half)

• New alternative camera passwords feature

• PTZ can nowbe disabled for specific CameraGroups set to ”Auto” configure

• Find screen performance improvements

• Motion detection state now reported via SNMP

• Disk formatting improvements

• Improved handling of slow disks in HyperRAID disk arrays

• Better reporting of Failover status via new ”Starting Up” state

• Improvements to automatic reconnection to iSCSI devices

• Added support for NASv2

• Many improvements to analytics engine integration

• User PTZ operations are now logged

• Improvements to SNMPTraps functionality

• Previous limit of 10 static routes removed

• Robustness improvements for N+2 (and above) RAID

• Fixed issuewith LDAP/ActiveDirectorywhen directory server is not contactable

• Fixed issue where, when removing a network interface from a bond group, secondary interface
failed to come back up automatically

• Fixed inaccurate percentage of storage volume value in Storagemenu

• Fixed someAxis camera streaming problems
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• Fixed issuewhere diagnostic download could cause freezes in video streaming

• Fixed issuewith Event Rules containing a Schedule AND other event cause

• Many otherminor improvements and fixes

11.2 WaveView Changes
• New analytics segment colour search (e.g. red torso, blue lower half)

• Support for alternative camera passwords

• Improvements to playback slider

• PTZ can nowbe disabled for specific CameraGroups set to ”Auto” configure

• Static routes can nowbe configured in Network setup

• Annotations can nowbe searched

• Deleting layouts now requires user confirmation

• Added configurable ”refresh time” for Find screen

• Better reporting of Failover status via new ”Starting Up” state

• Upgrade screen showsmessagewhen upgrade process is incomplete and needs repeating

• UpdatedOncamcamera dewarping integration

• Changes to configuration in Configuration Editor are now logged to system log

• AnalyticsCauses andZonespertaining to cameras that no longer have analytics support cannow
be deleted

• Layout browser now sorts by ID correctly

• Fixed issuewhere subtitlesweremissing on emailed video clips

• Fixed issuewhere initial aspect ratio button statewas incorrect

• Fixed issuewhere layoutswere always lockedwhen loaded

• Fixed issue relating to Jumbo Frames (MTU) in Network Setup

• Fixed issuewhere it was possible to have strange ”end” time on export

• Fixed issuewhere HotSpots change positionwhen resolution switches

• Fixed crashwhen selecting cameras inmap after server connection lost

• Fixed issuewhere clicking Undo after loading a layout switches back to live

• Many otherminor improvements and fixes
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12 Version 6.32.40 Changes

Note: Once a server has been upgraded to this version, it can only be downgraded as far as v6.16.

12.1 Server Changes
• Added support for PERCH750RAIDControllers

• Improved compatibilitywith Partizan cameras

• Improved logging of percentage of disk per recording track

• Improved disk recovery tools

• Improved storage enclosure detection

• Better handling of ONVIF cameraswhich sometimes don’t report their capabilities correctly

• Fixed some issueswith Honeywell cameras

• Fixed issuewith event rules using schedules

12.2 WaveView Changes
• Snapshot saving nowhas default filename for quicker saving

• Whenplayingback recordedvideo, if acamera layout is loaded, orcameraadded, thenewcameras
now continue playing from the same date/time

• Added ability to overwrite existing layouts

• When deleting an existing layout, user is now asked to confirm the action

• Added new ”write shared layouts” permission, allowing ”user” level users to write, overwrite, and
delete shared layouts

• Added ability to search Annotations by camera

• Fixed issuewith Status Summary exportwhen camera names include ampersands

• Fixed issuewhere ”transcodedexport” permission also affectedWSBexports for ”user” level users

• Fixed issuewhere layoutswere always lockedwhen initially loaded

• Fixed issuewhere aspect ratio button state could be incorrect

• Fixed issuewhere snapshot and annotation buttons in Find screenwouldn’t work
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• Fixed translation issue for en_US in Upgrade screenwhere progresswasn’t displayed correctly

• Fixed issuewhereWSB export frommultiple servers didn’t open correctly

24



13 Version 6.32 Changes

Note: Once a server has been upgraded to this version, it can only be downgraded as far as v6.16.

13.1 Server Changes
• Major update toOperating Systempackages

• Improved integration of Darkening eventswith SNMP

• Better integrationwith newWavestore analytics

• New system to support cloud-based StatusMonitoring

• PTZ improvements to allowdrawingaboxandzooming to that region, andAbsolutePTZposition-
ing

• Improved PTZ feature detection such that only supported features are offered

• NewChenbro X-Series chassismodel to be included in hardware detection

• Improved failover performance and reliability

• New ”force-failure” command to allow easier testing of failover

• New ”cameras” commandwhich lists details of all ONVIF cameras enrolled on the server

• New ”disk” commandwhich provides information about the specified disk

• Improved disk enclosure detection

• Improved handling ofmisbehaving but not completely failed disks

• Improved system and sensormonitoring

• Improved logmessages relating toMegaRaid arrays

• Improved password lockoutmechanism

• Improved support for Perc H740P disk controller

• Improved error handling of Auto/ONVIF/RTSP streams

• Better handling of camera transient dropouts

• Faster startup and shutdown

• Better device database namematch (for Hikvision cameras)

• Better support for SightLogix cameras
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• Increased default connection timeout

• Improved error reportingwhen diagnostic download zip file cannot be created

• Several fixes and improvements for HyperRAID andMegaRAID

• Fixed issuewhere server could sometimes rebootwhen intending to restart

• Fixed issuewhere VideoGuard integration could stopworking

• Fixed some issueswith camera streaming over SSL

• Fixed issuewith disk temperaturemonitoring for HyperRAID

• Fixed issuewhereONVIF audio output devicewouldn’t workwithout associated video stream

13.2 WaveView Changes
• New Hot-Spot functionality allowing configuration of areas on cameras which can be clicked to
switch to other cameras

• PTZ - allow drawing a box to zoom andmove to box area (for supported cameras)

• Newdockable Layout browser

• Allow panningmap areawithmouse click and drag

• Searchable camera list inMaps Setup andChannel Group Setup

• Newobjectmetadata types to supportWavestore analytics

• Support for openh264 encoder to allow transcoded exports to bemade in H.264 format

• Multiple-selection of cameraswhen setting upChannel Groups

• Multiple-selectionofcameras fromDeviceTreeallowingmultiplecameras tobedraggedontodis-
play area

• NewSetup Screen for cloud-based StatusMonitoring

• Improvements to remembering UI statewhen restartingWaveView, for example positioning and
open state of Live Event Stream, PTZControls, etc.

• Failover Setup now allows users to add and remove servers when Failover is disabled, plus im-
proved error reporting

• Messageswritten to server log are now translated server-side

• Newserver-side logmessagewhensavingconfigurationchangesfromConfigurationsetupscreen

• Command-line export tool has newCompression andOutput Resolution parameters

• Increased default connection timeout and updated Preferences UI appropriately

• Smart Search loop icon functionality fixed and improved

• Smart Search now sorts by percentage probability correctly

• Smart Search camera list now sorted correctly

• Various fixes and improvements to Analytics setup screen
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• Fixed System Log translations for several languages

• DeviceTreenowrememberswhether last viewwas theChannel TreeorGroupTree after restart-
ingWaveView

• Server Setup nowdisplays Failover Standby licences correctly

• Fixed Live Event Stream showing events in ascending order rather than descending by default

• Fixed handling of openingmultiple cameras after entering a filter for the Device Tree

• Fixed issuewhere, after doing transcoded export, last container typewas not remembered

• Fixed compression setting for transcoded exports as the effectwas inverted

• Fixed sorting of camera table in Cameras Setup

• Fixed issue with performing exports when video from one channel is linked to the audio from an
audio-only IP channel

• Fixed crashwhen using PTZ JoystickwhenWaveView is running on a non-primary display

• Fixed issuewith creating exportswhen camera or server names contain special characters
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14 Version 6.30 Changes

Note: Once a server has been upgraded to this version, it can only be downgraded as far as v6.16.

14.1 Server Changes
• Event Names can now include non-ASCII characters

• New textual setup screens for serverswith low graphical performance

• Default disk format changed toMTable4 - IMPORTANT: see section 34.3.1 - NewStorage System
Format (Sub3 andMTable4)

• Support for Azure cloud recording

• Improvements to cloud recording efficiency

• Updates AWS cloud storage integration

• Integration of newWavestore analytics device

• ImprovedWake-On-LAN utilities

• Major update of OS packages

• Disabled SSHCBCCiphers andweakMACAlgorithm

• Added tools to allow potential remote fixing of duplicate packages in corrupt installation

• Various improvements to reading andwriting configuration

• NewFaultmessagewhengrouptype isONVIF,Auto-configure isdisabled, VMDenabled, andPro-
file3 not configured

• Failover improvement - gratuitous ARP helps gateways and other clients reconnect correctly

• Analytics supported formore Bosch cameras

• Support formore events fromUniview cameras

• Improved support for Partizan cameras

• Improved feedbackwhen adding NFS volumes

• I/O devices stored as Alarm_N sections in configuration now allow gaps in numbering

• Added support for PERCH740RAIDControllers

• Newmechanism to prevent users reconfiguring HyperRAID arraywithout reformatting
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• Improved handling of slow disks in disk arrays

• Minor improvements to handling of hot-spares in HyperRAID arrays

• Improvements to shutdownmechanism,meaning faster software restarts

• Added logmessagewhen user account is locked

• Better errormessage logged to camera logwhen Subunit setting is invalid

• Better logmessages for failed streams

• Better logmessages if talkback is enabled but not supported by the camera

• Better Fault logmessage if suitable JPEGstream required for VMDandMotionSearch is not avail-
able

• For ONVIF EMS (Encoder/Multi-Sensor) cameras, audio channel now takes the subunit into ac-
count

• Better handlingofNVIDIAdrivers onupgrade -old version is removed, newversion installed, Fault
message logged stating that the systemneeds to be rebooted

• RTSPServer does not send RTCPSR packets

• Locked accounts no longer trigger Login Denied events

• Fixed erroneous logmessage stating ”Problemwith IP address”

• Fixed rare casewhere after recovery from failover, redirected recordings could not be accessed

• Locked down IPMI admin interface for Supermicromotherboards - disabled by default

• Fixed issuewhere old invalid AMDdrivers are still presentwhen upgrading

• Fixed issuewhere, on upgrade, some packageswould be listed for upgrade twice, causingminor
delays

• Fixed rare crashwhich could occurwhenmanyMxPEG cameras failed in a short time period

• Better handling of unresponsive cameras

• Better auto-configuration of Oncamcameras

• Fixed various issueswith Uniview cameras

• Fixed issuewhere image rotationwouldn’t alwayswork

• Fixed issuewith PTZ on Bosch cameras

• Fixed issuewhere ”Incorrect License” could be reported aftermisbehaving camera rebooted

• Various updates to camera database to add support formore cameras

• Various improvements to camera streaming

14.2 WaveView Changes
• Facility to import camera names, IPs, andmore from spreadsheet

• Status Summary export now supports exporting in ODS (OpenDocument Spreadsheet) format
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• Status SummaryODS export now includes snapshot of camera

• New setup screens for Cloud Recording

• New setup screens for integration of external analytics devices

• Many improvements to Analytics setup screen

• Analytics Smart Search now allows saved zones to be recalled and used

• Smart Search formultiple cameras re-instated

• UpdatedOncamSDK to 2.0 to support newdevices

• Improved PTZ operationwhen usingOncamdewarping

• Motion Search now remembers lastmask and sensitivity per-camera

• Option to search for the layout namewhen loading layouts

• Event Names can now include non-ASCII characters

• Event types in Find > Search > Events are now alphabetically sorted

• Protocols in Setup > Server > IODevices are now alphabetically sorted

• Some no-longer-needed UI elements removed

• Failed serverwithin failover group nowhas ”Failed” status indicated correctly in UI

• Minimumsupported Ubuntu Linux version updated to 18.04 LTS

• Video clip sent by email now include subtitles

• Fixed crash occurringwhen doing AVI export fromWSB exportwhere original video channel had
linked audio but the audiowasn’t included in theWSB export

• Fixed some issueswith the Load Layout dialog

• Fixed issuewhereChannel columnwasmissingwhen exportingmetadata search results

• Various UI language translation fixes and improvements

• Fixed issuewhere non-ASCII characters in email subjectwouldn’t work correctly

• Fixed issuewhere non-ASCII characters inWSB export file namewould prevent launching from
the included BAT file

• Fixed issuewhere Oncam cameraswould show a corruption on the right side of the image in the
Cameras setup screen

• Fixed issuewhere drag and drop of a Channel Group from the Device Treewouldn’t work

• Fixed slight inaccuracy in End Time of Event Search

• Fixed issue in Storage setupwhere disk partitions could not be added to HyperRAID arrays

• Fixed an issuewith parsing external event notifications

• Re-instatedWAV exports for audio-only channels

• Fixed issuewhere Sort ID in Live Event Streamwas always -1 for non-video channels

• Fixed several issueswith configuringmotionsmasks in Setup > Cameras
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• Fixed issuewhere Download Diags optionwas available evenwhen not logged in

• Fixed issue in Event Ruleswhere Audio trackwas incorrectly labelled as ’Authentication’

• Fixed issuewhere trailing spaces in configuration not shown in UI and therefore not editable

• Fixed issuewhere Status Summary could list cameras in unsorted order

• Various other performance and stability improvements

14.3 WaveSDK ActiveX SDK Changes
• IMPORTANT: This release is likely to be the last 32-bit release of the WaveSDK-ActiveX compo-
nent. Future releases will be 64-bit only. This version will be able to connect to past and future
versions of the server, but support for somenew functionality in future versionmay require newer
versions of the SDKwhichwill only be available for 64-bit.

• Fixed inconsistent behaviourwhich could occurwhen usingmultipleWConnection instances
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15 Version 6.28.25 Changes

Note: Once a server has been upgraded to this version, it can only be downgraded as far as v6.16.

15.1 Server Changes
• Fixed issuewith reconnecting to iSCSI devices after reboot/restart

• Fixed issuewith analytics formultiple cameras

• Fixed issuewith ONVIF PTZwhile reconfiguring camera

• Improved handling of unresponsive cameras

• Several other stability fixes

15.2 WaveView Changes
• Fixed issuewith analytics formultiple cameras

• FixedWaveView launcher for Ubuntu

• Fixed brokenWaveView icon
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16 Version 6.28 Changes

Note: Once a server has been upgraded to this version, it can only be downgraded as far as v6.16.

16.1 Server Changes
• Support for capture of video analyticsmetadata fromONVIF cameras, allowing real-time analyt-
ics event detection and historical analytics search, including:

– Object Class and Subclass search (e.g. Vehicle/Car), and probability of each.

– Object speed.

– Line Crossing

– Box Entry, Box Exit, Box Entry or Exit

– Object Removed

– Object Idle

– Crowding

• Metadata search performance enhancements.

• Facility to push and pull camera names to and from cameras.

• Various improvements to facility 3rd party integrations.

• New ’encrypt-keys’ command to generate encryption keys.

• New ’licences’ (or ’licenses’) command to output information about licences in use.

• New ’track’ command to report current and daily bandwidth used per recording track.

• Diagnostics download now includes server statistics.

• Statistics logging of CPU utilisation per CPU.

• Fixed issue where failover standby server wouldn’t take over if the logical server had a greater
number of physical network interfaces.

• Better error handling of ForeignMegaRAID arrays.

• Fixed issuewhere Diagnostic Download could time out.

• Fixed some issueswhich could causeOS partition to fill.

• Fixed issuewhere disks could be listed twice.
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• Fixed some error reporting of out ofmemory.

• Fixed potential video freeze and client time outwhen failover standby server is down.

• Improved handling of intermittently failing disk in HyperRAID array.

• Fixed issue of gettingONVIF Profile list for ONVIF cameras routed via a gateway (NAT).

• Fixed sending email via SMTP servers requiring no authentication.

• Many otherminor fixes and improvements.

16.2 WaveView Changes
• Major update tomain screen Smart Search facility to allow:

– Existingmotion search.

– All the new video analytics search types provided by the server.

– More detailed search results.

• New setup screen for Video Analytics.

• Event Rules setup for Video Analytics rules.

• StatusSummaryscreennowincludescameraIPaddressanddurationof recordingforeachrecord-
ing track, including in CSV export.

• Supporting for pushing and pulling camera names to/from cameras.

• Support for all EU languages.

• Default language is now automatically detected based on the operating system. It can still be
overridden in Preferences.

• Dewarping resolution downgradewhen panning is nowdisabled by default.

• Camera IP address is now a tag available for inclusion in subtitles.

• Facility to preserve current ”install” user details when importing a config file.

• Fixed issuewheremainscreenSmartSearchwouldonlyplayTrack1bydefault. ItnowusesEvent
playback preferences.

• Fixed video export frommetadata search results.

• Fixed issuewhere, on first login, twodialogs appear, one to changepassword and one to set time-
zone. They now appear in sequence.

• Fixed full-screen behaviour ofmultiple Video Display Areas.

• Fixed issuewhere changingCameraGroup type could cause incorrectmotion detection settings
to be locked in and unchangeable.

• Fixed corrupted dewarping for Oncamcameras on Linux.

• Fixed handling of events fromCentral Event Server.

• Fixed crashwhen clicking Export Preview in Export dialog.
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• Fixed issuewhere layoutswould not be savedwhenConfig Editor has sorting enabled.

• Fixed issuewhere disabled Event Ruleswould show as Invalid.

• Fixed issuewhereDefaultTracksetting inEventpreferenceswouldbe ignoredwhendoubleclick-
ing in Live Event Stream to play back events.

• Fixed issuewhere a sequences of Client Actions would not complete if there was an error with a
Play Sound action.

• Fixed issuewith showingONVIF Profiles in Camera Setup.

• Per-user language facility is now removed as it was not behavingwell.

• Many otherminor fixes and improvements.

16.3 WaveSDK ActiveX SDK Changes
• Fixed issuewhere spinningwheel, used during synchronised playbackwhen there is a gap in one
ormore streams, was notworking.
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17 Version 6.26 Changes

Note: Once a server has been upgraded to this version, it can only be downgraded as far as v6.16.

17.1 Server Changes
• New facility for configuring static network routes

• Redirectedchannelsno longeruseadditionalchannel licence-seesection17.4.1-RedirectedChan-
nels

• Support fornewMTable4storagesystem-IMPORTANT:seesection34.3.1 -NewStorageSystem
Format (Sub3 andMTable4)

• New separate licensing for Failover standby servers

• Metadata search performance enhancements

• Added configurable timeout and number of tries for password lockout

• ”stream” command now showsmetadata stream fromcamera, if present

• Added facility to stream video anaytics data via ONVIF, currently supporting only certain Bosch
cameras

• Improved feedback touser that themaximumnumberof recording tracks isabout tobe/hasbeen
reached

• Increased visibility of messages received from MegaRAID card indicating that a drive is starting
to fail

• Added support for raising Faults and appropriate events when individual units within a redunant
PSU fail

• RemovedDHCP fallback to 192.168.0.1 as it could conflictwith other interfaces on that subnet

• Added new event action to email a copy of the current configuration file

• The ”user”user isno longerpresentbydefault - toensure that theonlyuser is ”install” and thisuser’s
password is forced to be changed on first login

• More specific fault messagewhen connecting using RTSP to a device which is locked due to en-
tering thewrong username and passwordmultiple times

• Diskwrite rate now stored in server statistics

• ONVIF cameraswill be rebooted if reporting a 500 server error
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• Improved handling of failed attached iSCSI devices

• Added newHanwha AI camera events to the device database

• Added newHoneywell ONVIF events to device database

• Nowuses correct talkback typewhen using Auto camera group type and Axis P8221 device

• Fixed issuewhere Pre-event Framerate Boostwas shorter than expected

• Fixed excessive server logging relating to HTTP-Pull

• Fixed issue where recordings older than the maximum age could still be visible if they are after a
locked recording region

• Fixed issuewheremetadata searchwould return one entry after end time

• SMTP (email) settings are now copied to Standby server upon failover

• Fixed some issueswith disk statistics

• Fixed issuewhere cameras could report incorrect licensewhen the server just needs a restart

• Fixed issuewith incorrect error handling of video loss for Stretch analogue video channels

• Fixed potential crashwhen invalid encryption key entered

• Fixed video streaming for American Dynamics cameras configured using Auto configure

• Fixed PullPoint issueswith Eye Sonic cameras

• Fixed PullPoint issueswith Dahua cameraswhen using SSL

• Fixed issuewith Hikvision cameras lockout after failed attempts to login

• Fixed issuewhere disabled RTSP channels could continue streaming

• Fixed issuewhere Bosch Starlight camera image could flip upside after server restart

• Fixed issue where quality settings could beincorrectly chosen when configuring ONVIF media
profile

• Fixed issuewhere Auto camera group typemight not recognise change in IP address

• Fixed issuewhere FLIR camera could fail to streamH264when VMD is ON

• Fixed issuewith dual streaming cameraswith same resolution but different framerate

• Various other fixes and performance improvements

17.2 WaveView Changes
• Added support for drawing bounding boxes and polygons for analytics objects

• UpdatedOncamDewarping SDK

• Metadata Search performance and functional enhancements

• Ability to addmultiple camera IPs in range

• Synchronised playback improvements

37



• Added support for configuring timeout and number of tries for password lockout

• Various fixes and improvement to FileManager

• Several fixes and improvements for Oncamdewarping

• Fixed issuewhere the number of event causes in Event Searchwould keep increasing

• Variousfixestometadatasearch including inconsistentnumberof resultsand incorrect timezones

• Various other fixes

17.3 WaveSDK ActiveX SDK Changes
• Fixed issuewhere Server Group IDwould always increase every time a groupwas connected to.
The IDs are now freed after disconnection.

17.4 More Information

17.4.1 Redirected Channels
FormostCameraGroup types theWavestoresupportsdual, or even triple streaming fromeachcamera.
For some older types however, such as MxPEG, it does not. For that reason Wavestore has a system
whereby two channels can be configured to stream as different CameraGroup types, and the streams
fromone can be redirected to be a secondary streamon the other.

This feature was added in version 6.24, however it required a channel licence for each channel, even
though they are streamed from the same camera. In version 6.26 it does not require an extra chan-
nel licence as long as the redirected channel is disabled and has the same IP address or hostname as
the channel towhich it is being redirected.
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18 Version 6.24 Changes

Note: Once a server has been upgraded to this version, it can only be downgraded as far as v6.16.

18.1 Server Changes
• Improved handling of sudden power loss so as little recording as possible is lost

• Improved timestamp accuracy formetadata (e.g. for analytics)

• Added support for re-streamingMxPEGover RTSP

• Disabled S.M.A.R.T. disk checks on iSCSI devices

• Improved performance for Smart Search andMetadata Search

• New ”streams” command to show current live streams for a camera

• New ”UDP-out” integraton protocol

• Added support for analytics events fromAvigilon cameras

• Support for custom configuration to be added on Failover

• Better handling of network interfaces on failover

• Improved data recoverymechanisms

• Newfacilities tohandlecameraswithdiversemulti-streamsandunusualmotiondetectionstreams

• Upgraded Linux kernel

• Improved startup time of camera streamswith SSL enabled

• Improved support for install to QNAP devices

• Improved camera support

• Improved hardware support

• Newoptionmodule for integrationwith Eaton UPS

• Fixed issuewhere diagnostics download could time outwhenmany large files involved

• Fixed issuewith PTZ control when using cameras streaming over HTTP

• Fixed issuewith failoverwhen two servers directly connected, not via a switch

• Fixed issuewhere logical server in failovergroupwouldn’t raise aFaultwhenstandbyserver offline
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• Fixed several camera streaming issues

• Workarounds for issueswith faulty HTTPS implementations on several cameramakes

• Fixed issuewhere the time in ”Time&Region” setup screenwouldn’t updatewhen timezonewas
changed

• Fixed issuewith handlingmultiple frames in samemetadata packet

• Fixed issuewhere sensor reportingmight not show all sensors

• Fixed issuewith JPEG restreaming fromMobotix cameras

• Fixed issuewith formatting iSCSI volumes

• Various otherminor fixes and improvements

• Fixed auto-configuration of Avigilon cameras, camera could get stuck at 1fps

18.2 WaveView Changes
• Multi-playback of Smart Search results allowing quick analysis of search results

• Invalid or corrupt event ruleswould previously be hidden but now they are shown andmarked as
invalid, allowing them to be deleted

• Attempts to cancel a required password change are no longer accepted

• Users that don’t have permission to export footage now cannot save snapshots

• The log names in ”System Log > Extra Logs” are nowordered alphanumerically

• Now supports showing status of secondary failover standby server

• Fixed some issueswith translations and updated all translations

• BatchConfig Tool now allowsmass backup of configuration files

• Added ability to export to UNCnetwork location

• Improved playback ofmany cameras in Find screen on networkwith latency spikes

• Fixed issuewith aspect ratio setting being lostwhen double-clicking to go full-screen and back

• Fixed issuewhere double-clicking subtitle setup icon could cause the setupwindow to be lost

• Fixed issuewhere ”Windows”menuwouldn’t set correct initial states if in non-default language

18.3 WaveSDK ActiveX SDK Changes
• Added animated ”busy”wheel, usedwhenperforming synchronised playback and a camera has a
gap in recordings but others don’t
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19 Version 6.22 Changes

Note: Once a server has been upgraded to this version, it can only be downgraded as far as v6.16.

19.1 Server Changes
• 3rd stream can now be configured byWavestore. Previously it had to be a pre-configured Profile
or stream.

• New ’PTZ Tour’ Event Action

• Support formetadata search of object Idle, Removed, Speed

• Several improvements to Event Rules system

• Initial support forHybridcloudrecording(seesection19.4.1-InitialSupport forHybridCloudRecord-
ing)

• New facility to upload sensormonitoring data

• Improved disk retention time in HyperRaid arrays

• User account locking after repeated failed logins

• Support for several newhardware platforms

• Default config nowhas no timezone set, user prompted to set it correctly on first login

• User is asked to select keyboard layout on first boot up

• Canon PTZ cameras now support Pan Flybackwhen in Automode

• Several improvements to failoverwithmultiple standby servers

• Support for severalmore EMS (Encoder orMulti-Sensor) cameras

• Improved disk corruption recoverymechanism

• Fixed issuewhere low-privileged users could issueONVIFCamera commands

• Fixed issuewhere Smart Search datawould take up excessive disk space

• Fixed some issueswith Talkbackwhen usingMobotixMxPEG

• Many otherminor fixes and improvements

41



19.2 WaveView Changes
• Newuser permissions for editing and showing/hiding subtitles

• New ’ExtraLogs’ tabunder ’SystemLog’ toshowadditional server logs forcameras, disksandmore

• New setup functionality for Central Event Server, under ’Setup > Server Group’

• NewCamera Setup option to disable largeGOP sizewarning

• Mechanism to ensure user configures a Timezone if not already set

• Support for 3rd streamAuto-configuration

• Various fixes to newEvent Rules screen

• Event rule TextMatch configuration for Causes

• Fixed subtitle issue occurringwhen jumping server clock backwards

• Fixed issue showing server sound fileswhen configuring ’Play Sound’ event rules

• Fixed issuewithwrong resolution stream shownwhen returning to single camera view fromgrid
layout

• Fixed issue where configuration could be broken by copy/pasting newlines into various configu-
ration fields

• StoppedClient Event Actions from triggering on event Off

• Some fixes for ”Showmotion” in Camera Setup

• Fixed a timeout issuewhen retrieving Server Statistics

19.3 WaveSDK ActiveX SDK Changes
• New facility to disable information and errormessages inWVideoDisplayWidget

• Fixed issuewhereActiveXcomponentwouldnot jumpgaps invideoorsupportproperly synchro-
nised playback

• Fixed limitationwhere itwasnotpossible toexport frommultiple individual serverssimultaneously

19.4 More Information

19.4.1 Initial Support for Hybrid Cloud Recording
This releasehas initial support forHybridCloud recording. Thatmeans that,whilst it is recommended to
use the normal storagemechanisms for primary recording, it is possible to configure another recording
track to record to a cloud storage target.

There are currently noWaveView configuration screens to set up this functionality. It is recommended
to contact our pre-sales or support teams to discuss this feature in advance of using it.
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20 Version 6.20 Changes

Note: Once a server has been upgraded to this version, it can only be downgraded as far as v6.16.

20.1 Server Changes
• Major update to Event Rules engine (see section 34.3.2 - New Event Rules System). Changes
include...

– Support for Boolean logic for event causes (e.g. Input 1 AND Motion on Camera 3). Allows
AND, OR, XOR, NOT. (Note that ”NOT” support is not currently configurable inWaveView -will
be in a subsequent release).

– Support for customEvent Action types.

– Improved ”Post Event Time”mechanism- allowsextendingduration of event, addingdelays,
andmore.

– Improvements to handling of scheduleswith events.

– Metadata parametermatching (Note that this is not currently configurable inWaveView-will
be in a subsequent release).

– Improved Event Logging.

– Eventcauses for integrationsareautomaticallyaddedtoEventCauses list visible in theSetup
screen.

– EventP security enhancement to restrict IP of sources sending events to server.

– NewEvent Actions: CopyTrack, Door control.

– Event causes for network slow (link down) or network down.

– Legacy configured Events have Legacy post event time behaviour.

– Improvementswhen twoormore events triggered together (no longer suppresses someof
them).

• Support for recording and playback of talkback channels

• Support forImageRotation, alsoknownasCorridorMode(Note that ”NOT”support isnotcurrently
configurable inWaveView -will be in a subsequent release).

• Improvements in iSCSI disk handling: automatic reconnect after a disconnect

• HTTP Simple interface improvements:

43



– BOUNDS - provides range of recordings for a channel/track

– RECORDINGS - provides a list of recordings for a channel/track

• Some upgrade errors due to small install partition have been resolved

• Improvedmessages on newmid/oldmidMachine ID commands

• Failover:

– A newmode allowing Standby Streaming before failover

– Handling of SECONDARYSTANDBYmachines improved (more than one Standby is allowed)

– Failover: a limit of 40 failover servers in group has been enforced

– Failover redirect improved

• Metadata Capture fromONVIF cameras

• Improvements in camera setup and streaming:

– Ability to switch fromRTSP toONVIF streamingwithout restarting

– Additional entries in Device Database formore cameras

– ONVIF Imaging support for IRIS control

– Improved Auto-detect of camera type if not ONVIF

– Camera cache is cleared if unlicensed (or disabled) to ensure fast startupwhen licensed

– Improved handling ofmultiple channels on video encoders

– Better logging (alog) for HTTP andMxPEG cameras

– Multicast setup commands

– Auto-focus and auto-iris for Axis-http protocol

– Better Talkback support using Device Database in Automode

– H265 handling improved for out of band SPS,PPS,VPS

– Automatic switching to HTTP tunnelling if persistent failure on RTSP connection

– Imaging setting improvements

– ONVIF Relay outputs fixed

– ONVIFDigital Input numbering corrected

– Correctmessage shown if thewrong password configured for a camera

– RotateandVideoenabled/disabledarecached for rapidchangedetectionwhenreconfigured

– Improvements in AACdetection

– Camera N clear-cache command added

– PTZF profile selection improved in Auto/ONVIF types

– Fixed issuewith occasional corruption of images using Boost Pre-record

– Multicast improvements (SOAP)
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– Camera streaming improvements

– Improved fault reportingwhen server fails to stream fromcamera

• Secondary NTP address (for failover, etc); NTP server feedback

• More Statistics: Camera jitter; Ntp sync

• Support for deletion of aMegaRAID array via theGUI

• Device database entry for nonONVIF devices like VCA or Paxton

• Authentication:

– newmaster certificate to extend expiry date

– new self-signed authentication certificate by default, so it is no longer necessary to contact
WavestoreGlobal

– The server immediately starts using a new authentication certificate

• Simpler setup: Miscellaneous tracks configured usingCameraGroup as default

• Excessively largeGOP sizewill now raise a fault; option to disable

• Diagnostic log zip download

• SSDWear indication: Fault when about towear out

• Integrations:

– Axis VAPIX I/O: Input now supported

– HTTP-Out ability to set Cookie, to receiveMultipart

• Logging:

– Network link speed is logged in syslog

– MachineID logged in syslog at startup

• Thefrequencyof thePatrolReadfunctiononLSIMegaRAIDcardshasbeenautomaticallyamended
to reduce diskwear

• Restrict IP now allowsmultiple entries

• ONVIF/HTTP/RTSPServer:

– additional services offered by Wavestore Recorder are disabled by default to ensure maxi-
mumsecurity

– Improved RTSP restreaming: JPEG restreaming

– RTSPServer ”Speed:” field for faster playback

– RTSPServer clock: field now allows all ISO-defined formats

– Restreamingmultiple streams per camera via RTSPServer

• PTZ:

– PTZ configuration formultilens cameras and encoders updated

– PTZStop command is used in preference toMove x=0 y=0 to support buggy cameras
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• Command ’showports’ to produce list of running serviceswith open firewall ports

• Samsung SSD smart monitoring usedwrong attribute, now fixed. Note this might give a surpris-
ing ”wear” indication on first upgrade when it switches from the wrong attribute to the right one,
and as such this warning can be ignored if seen immediately after upgrade, but do pay attention
to subsequent warnings of SSD wearing out fast. The warning is given only when a lot of wear
occures in a short time. Use the ”ssd” command to see the life left: if it’s over 50

• Minor issues relating toMetadata Search invalid queries andmotion detection fixed

• Unnecessary logging has been removed fromFailover and LDAP

• Tunnelled RTSP over HTTP slow startup fixed

• Server Login nowno longer triggers two pulses for LoginSuccessful

• Logmessages tidied upwhen login fails

• Fixed issuewhere Talkback usedwrong channel when configured using oldmethod

• Camera command has nowmore information and has been tidied up

• Some oldmodes have been removed from LiveServerwhich should improve performance

• Malformed EventRule text fields nowgive correct error

• Y2038 and Y2036 issues resolved

• Server support for CameraGroups formoreGroup types (e.g. File)

• Image-Optimisation: Virtual SpotMonitor optimised

• Storagemenu improvements: no longer shows two entries listed for the same physical disk (one
shown as ’Missing’, the other shown as ’Unconfigured’)

• An issuewith repeated heading names in the server statistics csv file fixed

• Supermicro X11SSH-LN4Fmotherboard detection fixed

• Disk Array Failed now shows state of each disk

• The clear-tmp command no longer deletes server stats files

• alog logging output now correctly handles UTF8 characters in string

• Time display nowupdateswhen zone updates

• Server charsetwas not explicitly UTF-8 for text/plain HTTP served pages

• Memory checks added for large numbers of channels

• Execute command now returns errormessages

• Better logging of SystemStart

• Fixed Unexpected ’Sensors: fan1 = 0.0 rpm triggered alarm’message on Supermicro X11SSV-Q

• Fixed an Audio lipsync errorwhere the audio could be delayed

• Issueswith automatic network autoconfiguration (where changesmadeautomatically but no ”C”
lines logged) improved to avoid erroneous network configuration.

• User initiated time jump improvements: better instructions for users
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• UpdateOS packages to versions fixing latest CentOS vulnerabilities

• Various other security fixes

20.2 WaveView Changes
• Windows 7 and Windows Server 2008 no longer officially supported due to going End-Of-Life
withMicrosoft. Windows 8.1 andWindowsServer 2012 are theminimumsupported versions.

• New Event Rules setup screen to support new server Event Rules engine (see section 34.3.2 -
NewEvent Rules System). Changes include...

– Support for Boolean logic for event causes (e.g. Input 1 AND Motion on Camera 3). Allows
AND, OR, XOR. (Note that ”NOT” support is not currently configurable inWaveView -will be in
a subsequent release).

– Triggerable events onmain screen now show as ”Pulse” or ”On/Off” type

– ”Test on” and ”Test off” buttons on Event Rules screen nowwork for Causes and Actions and
for all types, as do the triggerable events on themain screen

– Improved setup formany event actions such as email sending or audio playback

– Support for ”Any” event sourcewhen configuring event causes

• New ”Client Actions” setup screen for configuring actions reacting to server events, including...

– Display of saved layouts

– Display of associated camera(s)

– Play sound

– Delay (timer)

• Support for recording and playback of talkback channels

• NewServerStatistics tool showinggraphsofmanydifferentstatisticssuchasnetworkusage, disk
usage, server status, etc.

• New tool tomake obtaining client and server diagnostics simpler

• Updated to latest Immervision SDK to support latest Panomorph lenses

• Support for new user permission to grant/deny ability to send events to the server, and restrict
source IP addresses.

• Improvements to zoom speedwhen usingmouse to control PTZ cameras

• Easier setup for recording image authentication signatures, events, andmetadata.

• Improvements to image authentication to allow self-signed certificates and new master certifi-
cate

• Certain ONVIF services nowdisabled by default with option to enable

• Addnew ”TalkbackType” parameter to allowusingdifferentmethods for audio talkback for certain
CameraGroup types.

• Minor simplifications to failover setup
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• Failover setup screen now imposes new limit of 40 physical servers in a ”failover group”

• Several fixes for issues in event rules screen due to newly implemented event rules system.

• Fixed an issue relating to resuming streaming after connection lost and restored.

• Fixed issuewhere recording durationwas limited in setup UI to only 99 days. Now999.

• Fixed issuewith Status Summary screen showing times in UTC only.

• Fixed issuewithmouse PTZ control not always being availablewhen it should be.

• Fixed some issues dragging and dropping between Video Display Areas.

• Fixed issuewithplaybackwhentryingtoskip recordinggapswhenmetadataenabledbutnometa-
data recorded.

• Fixed some subtitles issues relating to different displaymodes (server time, client time, or UTC).

• Many otherminor improvements and fixes.
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21 Version 6.18.27 Changes

Note: Once a server has been upgraded to 6.18.27 or later, it can only be downgraded as far as v6.16.

21.1 Server Changes
• Updated Italian translations

• Added newGET_RECORDINGScommand to allow theActiveXSDK to request a list of recording
start and end times of a track

• Improved handlingwhere jumping time backwards then rebooting could cause time jump to not
work. Note that it’s still advisablenot to reboot for awhile after jumping timebackwards. Theman-
ual describes the correct process in detail

• Improved upgrademechanism to better handle low disk space

• WS-Discovery protocol is now restricted to local networks

• Fixed someH.265 capture issues

• Fixed an issuewhere HikVision encodersweren’t correctly identified as encoders

• Fixed incorrect handling of permitted cameras for IDs 29+

• Improved handling of some cases of faulty camera streams

• Fixed an issuewith switching Virtual Spot Monitor on events when using new sub-stream func-
tionality

• Fixed an issuewhere AAC audio could fail to stream

• Fixed an issuewhich could causemulticast capture to fail

• Fixed an issuewith licensingmultiple EMS (Encoder/Multi-Sensor) devices

• Fixed an issuewith audio lip-sync

• Fixed an issuewith audio failing to capture from somemisbehaving devices

• LSI RAID card ”patrol reads” nowdisabled to reduce diskwear

• Fixed support for Supermicro-X11SSH-LN4Fmotherboardwith no extenal disk enclosure

21.2 WaveView Changes
• Updated Italian translations
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• Improvedwarningmessageshownwhen largetimechangesoccur inTime&Regionsetupscreen
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22 Version 6.18.15 Changes

22.1 Server Changes
• Added support for recording to files and improved NFS storage via new LASS-LIFT technology

• Added new ”Auto+” encodingwhich will favour H.265 for video and AAC for audio. Existing ”Auto”
encodingwill maintain H.264 andG.711

• Added support for restreaming H.265 over RTSP

• Added support for audio-only IP devices

• Added support for AACAudio including configuring it in Automodewhere available

• Added lots of performance statistics gatheringwhich can be downloaded asCSV

• Added support for triple streaming from IP cameras - see section 22.4.1 - Triple Streaming

• Added support for talkback via Axis VAPIX

• Added support forMoxa alarm boards

• Improved camera error reporting

• Added extra ”Unlicensed” state for disks (for when a configured storage feature isn’t available due
to licence restrictions)

• Added support for ONVIF PTZ Preset events (PTZPresetInvoked, PTZPresetReached, PTZPre-
setAborted, PTZPresetLeft)

• Addednewcommand for ”ExecuteCommand” todownloadconfigbackupfile: idownload-config

• File capture type now supportedwith newCameraGroups system

• Added log rotation rule for LSIMegaRAID log file (MegaSAS.log) to avoid filling OS disk

• Addedmore event handling for Avigilon, Dahua, Hikvision andMobotix

• Added sensors support for Gigabyte H87M-HD3, and Supermicro X11SCH-LN4Fmotherboards

• Faster camera startup

• Added new command for ”Execute Command” to list and delete locked recordings: getlock and
clearlock

• Various improvements to TCP andHTTP alarm outputmechanism

• IPv6 support for SNMP, VAPIX, and Failover
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• Removed 5 second startup kernel selection for UEFI systems

• AMD graphics drivers changed to use ”auto” instead of attempting to install old proprietary driver
whichwould fail

• Fixed talkback forMobotix cameraswhen using Auto or ONVIFmode.

• Fixed some issues playing audio clips on event

• Fixed some rare issueswith Pullpoint event subscriptions

• Fixed issuewith potential latency on Virtual SpotMonitors

• Fixed ”restore configuration backup” option inmaintmenu

• Fixed issuewhere PTZ on Uniview cameras sometimeswouldn’t stop

22.2 WaveView Changes
• Added support formultiple Video Display Areas

• Added awaveform visual representation for audio

• Added support for PTZ control viamousewithin Video Display

• Added support for audio-only and talkback-only IP devices

• Added ability to automatically start Layout Sequence on login

• Added support for triple streamed cameras

• Added a ”Window”menuwhich can be used to show/hide the dockwidgets in theMain screen

• Added Encoding and Audio Encoding settings to Camera setup, including Auto+mode

• Added extra functionality to DCZ joystick (Clear Layout, Wipe,Wash, Next Display Area, Select All)

• Enhanced options when importing server configuration file (can ignore importing network set-
tings, licence, disk assignments, and systemmonitoring settings)

• Support formulti-streaming to Virtual SpotMonitors

• Added support for Unlicensed and Foreign statuses in Storage setup screen

• Improved camera error reporting - clearermessages

• Improved performance of transcoded exports

• Fixed issuewhich could cause slow update of setup screens after visiting Cameras setup screen

• Fixed issuewhere talkback couldn’t be turned off after visiting the setup screens

• Fixed issuewith Free layouts in Layout Sequence not displaying correctlywhen full screen

• Fixed several issueswith the event filter preferenceswhen receiving customevents

• Fixed several issueswith configuring integrationmodules in I/ODevices setup screen

• Fixed some issueswith privacy andmotionmasks relating to dual/triple streaming

• Fixed erroneous DHCPwarningmessage for disabled network interfaces during Failover setup
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• Fixed issuewhere export directorywasn’t automatically created byWaveview if non-existent

• Fixed issuewhere progress informationwasn’t shown for transcoded exports

• Fixed issuewith playing through recordingswith gaps in audio stream

22.3 WaveSDK ActiveX SDK Changes
• Added facillity for getting recording index data for timeline

• Added facility for openingWSB archives

• Addedmouse double-click events

• Added drag and drop events

• Added slow playback functionality (x0.1 to x2.0 speed)

• Added snapshot function toWVideoDisplayWidget

• Example application now shows how to take snapshots

• Example application now shows how to do Live Recording

• Newoutputwindow to showmouse events

22.4 More Information

22.4.1 Triple Streaming
Note that Stream3 is only available for the group types RTSP, andONVIFwith ”Auto-configureCamera
Streams” set to No. Stream3 cannot be used for live viewing, only for recording.
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23 Version 6.16.66 Changes

23.1 Server Changes
• Fixed problemwith NVIDIA drivers - important for PT-Series and PD-Series owners

• Corrected drive numbering for AIC-12G-4U24SAS3EOB enclosure with Supermicro-X11SSH-
LN4Fmotherboard
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24 Version 6.16.62 Changes

Version 6.16 is a new releasing containing many new features. There is also a major update to the un-
derlying operating system in order to provide support for the latest hardware. Note that theOSupdates
are only provided when installing version 6.16 afresh. Wavestore systems installed with earlier versions
and upgraded to v6.16will remain on the existing underlyingOperatingSystem. This is not a problemas
these updates are only required for newer hardware platforms.

24.1 Server Changes
• Added support for H.265 video (note that RTSP re-streaming of H.265 is not yet supported).

• Added support for IPv6. See section 24.4.4 - IPv6 Support.

• Added support for separate licensing of encoder and multi-sensor camera channels. See sec-
tion 24.4.1 - Separate licensing of encoder andmulti-sensor cameras formore information.

• NewCentral Event Server feature allowing forwarding of events from servers in a group to a cen-
tral server where rules can be applied. See section 24.4.2 - Central Event Server for more infor-
mation.

• Support for installation to UEFI systems.

• Major update of OS kernel and other OS packages.

• Added support forwhitelist of permitted cameras for users, in addition to the existing blacklist.

• Added support for ONVIFMedia2 Service including camera configuration.

• ImprovedONVIFcameraconfigurationmechanismtogive faster startupandwider compatibility,
including allowing automatic camera configurationwith Failover.

• Improved fault reporting policy in the System Log and Event Stream

• Improved camera disconnectmessages.

• Added facility to device database for selecting H.264 Profiles.

• Added facility to device database for enabling or disabling Digest Authentication.

• Added new ”Failover” event cause.

• Added network problemdetection for camera streaming.

• When a camera is being reconfigured the old stream now continues until the new one is ready.
This reconfiguration is signalled to clients.
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• Support for Virtual SpotMonitors to switch to low-resolution stream.

• Support for Virtual SpotMonitor Trigger Rollover. See section 24.4.3 - Virtual SpotMonitor Trigger
Rollover formore information.

• Added Axis event causes: IO, Signal Loss, Global SceneChange, Image TooDark, Tampering, Vir-
tual Input.

• AddedHanwha event causes: Appear, Disappear, Loitering, Virtual line, Enter/Exit, Defocus Detec-
tion, Fog, Motion Detection, Tampering, Face Detection, Audio Detection.

• AddedMobotix event causes: Motion events.

• Added support forMODBUS over TCP such as Advantech ADAM

• Added 4K to list of default resolutions.

• Added setting to determinewhether internal or externalmotion events should be used.

• Improved logging of disk performance issues.

• Improved logging of SSDWear.

• Improved logging of ONVIF camera configuration.

• Improved handling for talkbackwhen enabled but not supported by the camera.

• Bettermanagement and reporting of RAMusage.

• Better logging of received events.

• Support for VideoGuard/SIRASpecification.

• Many improvements to camera compatibility.

• Fixed issuewith enclosure detection for Supermicro devices.

• Fixed issue where Recording indicator could remain active when recording to failed HyperRAID
arrays.

• Fixed issuewith syncing to NTP sources via hostname.

• Fixed ’Hue’ setting on Stretch analogue capture cards.

• Fixed issuewhere Login Denied event could trigger event action twice.

• Fixed issuewhere disabled cameras could raise Faults.

• Fixed issuewith streamingMPEG-4 over RTSP.

• Fixed issuewith password synchronisation between servers in a Failover group.

24.2 WaveView Changes
• Added support for H.265 video.

• Added support for IPv6.

• Addedsupport forspecial licensingofencoderandmulti-sensorcamerachannels. Seesection24.4.1
- Separate licensing of encoder andmulti-sensor cameras formore information.
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• Added support forwhitelist/blacklist of permitted cameras for users.

• Added newShared Layouts facility. Layouts created by one user can be sharedwith other users.

• Added new Layout Sequences facility. Allows showing layouts for a configurable period of time
before switching to another layout, repeated in a loop.

• Improved UI scaling for high DPI displays.

• Added ability to select joystick to use in casemultiple devices detected.

• Removed unnecessary stepswhen switching to Dewarpmode.

• Further improvements to newCameras setup screen.

• Added Volume and Input Selection (line ormic) controls for audio channels.

• Added ”Camera Setup Page” browser shortcut to theCameras setup screen.

• Added error highlighting to theCameras setup screen.

• Added 4K to list of preset resolutions.

• New ”Main View” setup screenwhich contains the existingChannel Groups andMetadataDisplay
setup screens, aswell as a new setup screen for Layout Sequences.

• New setup screens for Advantech ADAMandMoxa I/O devices.

• New setup screen for SNMP configuration.

• Added integrationevent facility for launchingcamerasfromdifferent timesandservers in theserver
group.

• Increased default log size to 100MB.

• Disk Setup Screen now indicateswhen disks are in Readonlymode.

• Encryption Setup Screen now shows public encryption key.

• Added a subtitle entry that indicateswhether the camera is currently being reconfigured.

• Subtitles now showbitrate in bits/s instead of Bytes/s by default.

• Newpreference ”Gap Threshold” to determinewhen to skip areaswith no recordings.

• Improved ”ExecuteCommand”windowtobe faster, alwaysappendoutput toend, andauto-scroll
to end.

• Improved handling of automatic user logoff.

• Improved speed and fixed some problemswith the System Logwindow.

• Fixed issueswithWSBexportswhere invalid characters in cameranamesor filenamecouldcause
problems playing back.

• Fixed issuewhere properties for CustomEventswould not be applied in Events Preferences.

• Fixed issuewhere initial dewarping view could be corrupted.

• Fixed several issueswith transcoded exports including glitchy audiowithmp4 andmov.

• Fixed issuewhereGlobal Talkback button didn’t work reliably.

• Fixed issuewheremaximumsensitivity formotion or smart searchwould always detectmotion.
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• Fixed tab order in Network setup screen.

• Fixed issuewhere digital inputs could be numbered incorrectly.

• Limited analogue spotmonitor configuration to only the allow analogue cameras.

24.3 WaveSDK ActiveX SDK Changes
• Added support for H.265 video.

• Added support for IPv6.

• Resolved limitation where it was not possible to export from multiple servers (note that for WSB
exports, only one server group is supported).

24.4 More Information

24.4.1 Separate licensing of encoder and multi-sensor cameras
Version6.16 introducesanew licensingoption for encoders andmulti-sensor cameras to lower thecost
of deploying systems that utilise these technologies. The newEncoder andMulti-Sensor (EMS) licence
type is available at all levels (BASE, PREMIUM, ENTERPRISE and ULTIMATE) which licenses the entire
encoder ormulti-sensor camera instead of each individual channel.

EMS licencescanbemixedandmatchedasnecessarywith individual IPchannel licensesacrossasolu-
tion. Thismeans thatWavestore customerswhowish to continue using legacy analogue cameras, now
only require a single EMS licence in order to use a 16-channel standard definition encoder, a 4-channel
AHD/TVI/CVI encoder or amulti-sensor camera from a host ofworld leading brands.

Note that old style licenceswhich do not have a separate field for ”permitted EMSdevices”will continue
towork as in previous versions. That is, each channel on the device requires one ”permitted IP channel”.

Fornew licencessuppliedwithoneormore ”permittedEMSdevices”, anyEMSdeviceconfiguredon the
systemwill only be checked against the permitted number of EMS devices andwon’t fall back to using
”permitted IP channels”.

24.4.2 Central Event Server
The Central Event Server (CES) is a powerful and extensible feature of Wavestore which allows all (or
some)events fromtheLiveEvent streamonanumberofWavestoreservers tobe forwarded toacentral
serverwhichwe call the ”Central Event Server” or ”CES”, which can process the events.

TheCentral EventServer is just oneof theWavestore servers in theServerGroup, it doesnot require any
special hardware, just a suitably licensed system.

For example: consider a systemwith 5 Wavestore servers all in one Server Group. Server 1 can be set
as the Central Event Server, and this will pull events from the other servers in the group automatically
(providing theCES has been enabled).

There are anumber ofwaysof configuring it, dependingon requirements. Usually it is used to aggregate
events from sources on different servers. Thiswill generally be required by certain IntegrationModules
andconfiguration instructionswill beprovidedwith theIntegrationModule. Bydefault theCentralEvent
Server functionality is disabled.

58



Currently there is no UI for configuring this, but the Configuration Editor can be used to enable it with
guidance fromour support team. A full configuration UIwill come in the next software release.

24.4.3 Virtual Spot Monitor Trigger Rollover
Up to version 6.14 the Virtual Spot Monitor feature allows events to cause cameras to be switched to
another camera feed. For example camera 100 might be a Virtual Spot Monitor and cameras 1 to 50
might be configured to route their video to camera 100whenmotion occurs. This new Rollover facility
allows these events to be passed to ”free” virtual spot monitors if the first one is busy. For example if
camera 100 is showing camera 1 due to motion, then motion occurs on camera 2, it can ”rollover” to
camera 101 (another spotmonitor).

Currently there is no UI for configuring this, but the Configuration Editor can be used to enable it with
guidance fromour support team. A full configuration UIwill come in the next software release.

24.4.4 IPv6 Support
In version 6.16, support for IPv6 is introduced. However a few less commonly used features do not fully
support IPv6 as yet. Thesewill be added in future releases. The not-yet-supportedwith IPv6 features:

• Axis I/O Devices using the VAPIX interface such as the Axis P8221

• SNMP v2c Traps (for sending event notifications)

• Failover

• Capture ofmulticast streams
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25 Version 6.14 Changes

Version 6.14 is amajor new release strongly influencedby customer feedback. Themajor areas of focus
were ease-of-setup and delivering new improved storage technologies, althoughmany other changes
and improvementswere also developed.

Be sure to read section 34.3.3 - Important Information about New Configuration Format before up-
grading.

25.1 Server Changes
• New HyperRAID, HyperRAID Plus, and EcoStore technologies - see section 25.4.1 - HyperRAID
and EcoStore

• Support for recording to disks in sequence

• New facility to identify Faulty and Spun-downHard Drives via SASSideband LEDs

• New facility to identify disks by Drive Bay numbers for supported enclosures

• Improved events on HDDFailure for HyperRAID and single drives

• Support for CameraGroups

• ImprovedCamera Discoverymechanism

• Improved detection and configuration ofmulti-lens cameras and encoders

• Support for HTTPDigest authentication

• Improved licensing for integrationmodules

• Improvements to network licensing to allow easier virtualmachine cloning

• PTZ for ONVIF devices now automatically enabled if supported

• Newrecordingmodes including facility for scheduledPermanentRecordingandEventRecording
on the same track

• Ability to Boost framerate on schedule

• Smart Search andmotionmask improvements

• Support for internalmotiondetection for IPcameras - seesection25.4.2 - InternalMotionDetec-
tion - SupportedCameras for requirements.

• Support for Audio and Talkback on same channel as video, rather than as a separate channel
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• Nightly logs now report range of recording, not just earliest

• Ability to remotely viewOS kernel log

• Ability to showblank imagewhen Virtual SpotMonitor channel has no camera assigned

• Support for SNMP v2c protocol including for SNMPTraps

• AddedWavestore RTSP type to RTSP profile list

• Better text provided for ONVIF flags options

• New facility to auto-backup configurationweekly andwhen a configuration is loaded

• Email video clip script can now take container format as an option

• Added genericmulti-channel Axis encoder request strings

• AddedDedicatedMicros HTTP request string

• NewMaintenanceMenu option to forcemonitor resolution for client on server

• Addedwearmonitoring for Supermicro SATADOMSSD

• Sensor and SSD-monitoring configurationmoved to separate ”wavestore-hardware” package to
allow easier backporting

• Disabledmotherboard audio in hardware detection by default, optionally enable

• Support for auto-focus via ONVIF and other PTZ improvements

• ImprovedhandlingofResolutionandEncodingsettingswhenusing ”Auto-configurecamerastreams”

• Improved disk fault reporting

• Fixed issuewhere errorswith emailing video clips could be re-loggedmultiple times

• Fixed issuewith emailing tomore than 10 potential recipients

• Fixed issuewith timestamps in non-UTC time zoneswhen sending emails

• Fixed issuewhere server didn’t unsubscribe fromONVIF PullPoint

• Fixed several issues relating to failover and failover recovery

• VariousONVIF and RTSP streaming improvements and fixes

• Fixed USB ISO ”RecoveryMode”

• Fixed some caseswhere server unnecessarily requested restart

• Fixed issuewith preserving server licensewhen defaulting config through ”maint”menu

25.2 WaveView Changes
• NewSimpler Camera Setup

– ”All tracks” settings

– ”Auto” type

– Automatically enable PTZ for ONVIF devices if supported (Client)
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– Audio and Talkback on same channel as video

– HDOptions in Resolution Dropdown field

– Implement client polling for network discovery of ONVIF cameras

• NewServer Setup Screen containing submenuswith formerly top-level setup screens

• New Licence screen and support for new licence levels

• Opening associated cameras from event/metadata performs best fit

• Smart search andmotionmask improvements

• Disk Setup Screen updates for HyperRAID and EcoStore, plus ”FlashGoodDrives” facility

• Export improvements including...

– Tidied up list of encoders for transcoded exports, removing old codecswhich don’t function
well and fixingmany others

– Find screen no longer has export toolbar as the Find screen flags should be used instead

– Improved handling of ’from’ and ’to’ flags to ensure they are correct

– Fixed issuewhere linked audio channels > 128wouldn’t work inWSB export

– Fixed issue exportingwhen audio is continuous but video has gaps

– Fixed issuewhere exportedWSB export could have an inactivity logout timer if the user that
made the export had this configured

– Other general improvements and fixes

• Preset and Tour support for joysticks/keyboards

• Added support for Videotec DCZ keyboard

• Enhanced quick annotation time selection

• Fixedmajor freezing on live streaming (client)

• AddedGUI buttons for auto-iris and auto-focus

• Metadata improvements

– Movedmetadata visualisation settings to the server configuration file

– Point of Sale and overlay console visualisation now start streaming automatically

• Facility to list and restored backed up configs

• User’s layouts are nowdeletedwith the user

• Removed Execute Command function fromConfig Editor screen as it’s available under Tools

• Added support for ”force failover” event action

• Betterdescriptions forcertainevent types, e.g. ”GenericFault”nowshows”Fault (seeSystemLog)”

• Customevent causes now available on Events Preferences and Event Search

• Added support for integrationwith KeyScan

• Fixed clicking sound on audio playback
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• Fixed some issueswith ”Live Buffering”modewhich could cause spinningwheel

• Re-addedmechanism for de-highlighting selected items in live event stream

• Fixed issuewhere client could fail to automatically reconnect to serverwhen ”TooManyConnec-
tions” error occurs

• Improved Linux packaging to fix issues deploying to some Linux distributions

• Fixed issuewhere the camerawould become smaller when the video stream has different reso-
lutions over time

• Fixed issuewheremap imageswith spaces in filenamewouldn’t upload

25.3 WaveSDK ActiveX SDK Changes
• Support for auto-iris and auto-focus

• Support for audio and talkback on same channel as video

• Some export containers and codecs have been removed due to lack of reliable operation. Please
check the new list using the API as described in the ActiveXmanual or contact our SDK Support
team formore information

• The PtzfEnabled property is nowdeprecated. See ActiveXmanual for details

• This release is ABI compatiblewith the previous version 6.12

25.4 More Information

25.4.1 HyperRAID and EcoStore
HyperRAID™ is a new technology unique toWavestore providing cost-effective redundancy in storage
arrayswhilst performing faster than traditional RAIDwithout requiring a traditional hardwareRAIDcard
to operate. This technology is compatiblewith awide range ofWavestore servers and various disk con-
trollers. Full details can be obtained upon request.

Along with HyperRAID™, version 6.14 adds the ability to record to multiple ’disk groups’ in sequence. A
disk group could be a single disk or a HyperRAID array. These disk groups can then be spun down, or
de-activatedwhen idle, to save energy consumption and heat output. The combination of these tech-
nologies is known as EcoStore® .

EcoStore is a registered trademark of Wavestore Global Limited.

25.4.2 Internal Motion Detection - Supported Cameras
The new internal motion detection is designed to work for ONVIF Profile S compliant cameras which
are capable of transmitting a JPEG streamof 648x648pixels or less. Note that this JPEG stream is used
as an additional stream from the camera on topof any existing configured streams, so the cameramust
be capable of this.

The JPEG stream is a low resolution stream at 4 frames per second and so some extra bandwidth is
used for this.
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This functionality isdescribed indetail in thesection ”ConfiguringMotionDetectRecording”of theWave-
storemanual.
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26 Version 6.12 Changes

26.1 Server Changes
• Upgrade Bundles are now enforced. IMPORTANT - please read section 34.1 - Important Infor-
mation About Upgrading, Licensing, and Upgrade Bundles before upgrading.

• Support for capture and record ofmulticast streams fromONVIF devices.

• Support for connecting toONVIF devices via TLS/SSL.

• Support for Recording Lock facility (was available in version 5, now added to version 6).

• NewExecutable Command to reboot the camera.

• Various I/O improvements for 3rd party integrations.

• Improved logging in RTSPServer.

• Improvements to Network Licensingmechanism include better errormessages.

• New command to query status of event causes, used primarily byMaps inWaveView.

• Email sendingmechanismnowhas a new throttlingmechanism.

• Increased size of root partition for new installs from6GB to 10GB. Overall requirement for system
disk increases from around 17GB to 21GB. Should still fit easily on even the smallest SSDs.

• General improvements to IP camera compatibility.

• Someminor improvements relating to failover.

• General improvements relating to sending emails.

• Fixed issuewhere ”force user to change password on next login” wouldn’t alwayswork.

• Fixed issuewhere ”ShutdownSystem”via remoteclientwouldn’tsuccessfullyshutdownA-Series.

• Fixed problemwith PTZ control when using RTSP dual streaming.

• Fixed problemwith RTSP re-streamingwhen capturingwith RTSP dual streaming.

• Several fixes relating to Virtual SpotMonitor sequences.

26.2 WaveView Changes
• Variousmap improvements including...
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– Mapconfigurationand imagesarenowsavedonserver insteadofclient, easier systemsetup.

– Maps now showcurrent alarm status on entry.

– Maps editmode nowmoved to the setup screens.

– Maps nowcorrectly handle Digital Inputswithin server groups.

• NewStatus Summary Screen allowing quick view of all cameras in the server group.

• Various improvements and fixes relating tometadata visualisations including...

– Metadata visualisations are now associated with cameras via the setup screen. No need to
choose each time one is opened.

– ”In-display” visualisations such as Text Overlay are nowopened automatically.

• For ONVIF stream settings, a custom resolution can nowbe entered.

• Various improvements to the FileManager.

• Various improvements to allow better integration of 3rd party systems such as ANPR/LPR.

• Whenmaximising a camera froma layout it nowautomatically switches tohigh resolution stream.

• Enforcement of Upgrade Bundles including checking andwarningwhen appropriate.

• Re-added concept of ”viewed” events in live event stream (was in version 5 but not version 6 until
now).

• Fixes and improvements to Virtual SpotMonitors including...

– Dwell time nowdefaults to 5 seconds instead of 1.

– NumberofVirtual SpotMonitors channels limited to2, otherwiseundesirable issuesmayoc-
cur.

• Setup screen support for ONVIFMulticast devices.

• ”Server awaiting restart” now shown on setup status bar tomake itmore obvious.

• The behaviours of the various ”Tools” windows are nowmore consistent.

• The ”auto control toolbar” functionality is now removed as it wasn’t predictable. Can still be used
manually.

• Adding cameras to a free layout now tiles displays (a little down and to the right compared to pre-
vious camera).

• Newpreference to enable/disable ”Lower resolution thresholdwhen panning”.

• Manually triggered events fromEvent Rule screen (Test On / Test Off) now logged to SystemLog.

• Annotation storage settings now configurable.

• Old limit of 255 users increased to 9,999.

• Improved UI for ”FlashGoodDrives” function.

• Improved joystick Shuttle and Jog functions on Linux, tomatchWindows functionality.

• Email Server setup screen improvements to support new email throttlingmechanism.

• Improved decoders and logging of decoding issues.
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• Fixed issuewherestreamswithchanging resolutionscouldcausedisplay togetsmallereach time.

• Fixed issueswith duplicated event causeswhen addingmultiple actions.

• Fixed several issueswith adding new I/O devices for integrationmodules.

• Fixed issuewhere tooltip text onWindowswas hard to read.

• Fixed issuewhere dismantling server group could leave old erroneous configuration.

• Fixed issuewhere setup screenswouldn’t work on some laptopswith newNVIDIA drivers.

• Fixed issuewhere schedule setupwould not allow continous overnight period.

• Fixed issuewhereopeningpassword-protectedWSBexport takenfromservergroupcouldcause
password prompt to appear once per server.

26.3 WaveSDK ActiveX SDK Changes
• IMPORTANT - The ActiveX SDK now requires version 5 or version 6.12 and above, earlier version
6 servers not supported.

• Added support for encrypted recordings.

• Added support for licensed integrationmodules

• Fixed issuewhere the ActiveXDLL version numberwas incorrect

• Various other fixes and improvements. See the WaveSDK ActiveX Reference Guide for more in-
formation.
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27 Version 6.10 Changes

27.1 Server Changes
• Major update to the operating system.

• Performance improvements relating to live streaming

• New ”Recording less than intended” event cause

• Many improvements toONVIFcameracompatibilityand featuressuchasautomaticcameracon-
figuration, audio and talkback, multi-streaming, and device discovery. Includes improved error
logging.

• Fewer IP camera setting changes require server restart

• RAID Faults now trigger Disk Fault event cause

• Reboots caused bywatchdog are now logged as a fault after system comes back

• Allow suppression of Pullpointmessages from cameras in Live Event Stream

• Commands for jumping time forwards and jumping backwith deletion of footage

• Ability to do graphics driver install and uninstall remotely

• Pre-event framerate boost now fully supported in V6 LASS file format.

• Upgraded proprietary NVIDIA and AMDgraphics drivers

• Significant improvements in Axis-HTTP PTZ protocol

• Nightly reports are nowoutput atmidnight localtime, not UTC

• Various improvements to allow integrationswithmore 3rd party devices

• Various improvements relating to handling of LSI RAID cards

• Various failover improvements

• Fixed issuewhere faultmessages could occur for disabled IP audio channels

• Fixed potential problems switch to and frombonded network interfaces

• Note: Software Support Agreements are not enforced in this version. Theywill apply to v6.10.
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27.2 WaveView Changes
• Changes to layout double-clickmode - see Changes to behaviour of double-clicking displays

• ONVIF Camera Setup - ”Allow Wavestore to configure streams” and ”Enable PullPoint” now en-
abled by default for easier setup.

• NewError Codes for video displays to show camera statusmore clearly

• Added support for new ’Recording less than intended’ event cause

• Variousminor UI improvements including:

– Tidied upmain screen dockwidget containing playback, event, and PTZ controls

– Thinner border for selected video displays

– Clearer icons for alarms inmap viewer

• Various improvements to joystick PTZ control

• Various fixes and improvements relating to Disks Setup and LSI RAID cards

• Exports are now correctly logged to system log

• Server UID is nowwritten in client log upon connection

• Improvements to smoothness of video streaming over busy networks

• Various non-relevant screens are nowdisabledwhen viewingWSB export

• Front screen now remembers folded/unfolded state of dewarped view(s)

• Updated Immervision-enables dewarping library

• Fixed potential issueswith configuration syncwhen network connection to server lost

• Fixed a rare and somewhat random crash which could occur when manipulating camera posi-
tions in layouts

• Fixed setup screen for analogue audio and volume level control

• Fixed some issues leaving Find screenwith the on-serverWaveView client

• Fixed some issueswith configuring Virtual SpotMonitors

• Fixed issuewhere playback controlswouldn’t alwayswork on selected cameraswhen displaying
multiple cameras

• Various improvements to export and playback ofWSB files from server groups

• Many otherminor bug fixes and improvements

27.3 WaveSDK ActiveX SDK Changes
Amajornewrevisionof theWaveSDK-ActiveXSDK isavailable in6.10. Theunderlyingcomponentshave
been revampedwith enhanced performance,modern architecture and improved flexibility. Keeping up
with the best development practice the API is nowmore consistent and easy to use. By improving the
example code and including small snippets in the documentation thedevelopers canquickly get up and
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running with the latest SDK. Several new features are available in the new release. The core features
included in the SDK are listed below.

• Connect to variousWavestore servers.

• Wavestoreservermanagement routinessuchas restartprocessand rebootandshutdownserver.

• Retrieve a list of cameras and audio inputs and outputs, configured on each server.

• Full playback control (e.g. live, play, fast-forward, rewind, frame-step back, frame-step forward,
jump to beginning and jump to end of video)

• Full PTZ control (e.g. vector PTZ commands, focus, iris, wash, wipe, lamp, recall tours and presets.)

• Search in the pre-recorded video based on date and time.

• Receive informationwhen the servers are changed (e.g. lost connection, reconnected, configura-
tion changed, other changes or errors).

• Stream video to an ActiveX control or receive raw decoded data.

• Dual Streaming capability, i.e. switch between a high or low resolution stream.

• Additional functions are available for the video streaming ActiveX control:

– Display a subtitlewith image information overlaid on the stream.

– Zoom in and out around a coordinate in the stream.

– Keep aspect ratio or fill thewhole control.

– Receivemouse andwheel event.

• Bidirectional audio (audio and talkback).

– Retrieve decoded audio data and play it through a provided audio player.

– Input rawdata toa talkbackchanneleither throughanaudiofileorusing theprovided record-
ing device class.

• Create annotations to identify events.

• Receive events from the server. Each event includes:

– The date and time ofwhen the event occurred.

– The cause of the event.

– Other information such as the source name, server name and additional text related to the
specific cause of the event.

• Trigger rules (event causes/actions) configured on the server.

• Export recordings from different tracks to different formats (both transcoding as well as to our
own .wsb format).

27.3.1 SDK Changes versus Version 5
• Dewarping is no longer supported.

• Encrypted recordings are no longer supported.
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• Event notification system is no longer supported. All the events are now automatically passed
through to the ActiveX SDK.

Note that if the above features are required, the version 5.54 WaveSDK-ActiveX SDK can still be used
with version 6 servers. It is planned that featuresmissing in the newSDKwill be addedwithin the next
few releases, in an improved form.

27.4 More Information

27.4.1 Changes to behaviour of double-clicking displays
When viewing amulti-camera layout in previous versions ofWaveView, the behaviourwas as follows:

• Double-clicking a camera would enter a ”solo mode”, showing just that camera, yet leaving the
layout in its previous state, e.g. ”3x3”

• Double-clicking the camera againwouldmake that camera full-screen

• Double-clicking againwould return to the original layout

This concept of the ”solo mode” has now been removed as it could result in unexpected behaviour in
certain circumstances. As of version 6.10 a double-click of a camera in a layout will full-screen it, and
another double-clickwill return to the layout.

If it is desired to solo a camera, simply select the camera and change to a 1-way layout.
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28 Version 6.8.78 Changes

28.1 Server Changes
• New facility to record any track to two disks simultaneously

• Resolved issuewhere dual-streamingwould not alwayswork for secondary stream

• Support for pre-event framerate boost

• Fixed issuewith failover redirection of recordings

• Fixed issuewith failover incorrect handling ofmultiple and bonded network interfaces

• Fixed issuewhere faulty cameras could cause ”TooManyOpenHandles” error in server

• Fixed issuewith ’slewtimefast’ command for clock correction

• Improved logging for disk performance

28.2 WaveView Changes
• NewMap Edit permission per user

• Support for new server Disk2 parameter, to record to two disks simultaneously

• Fixed issuewith openingWSB exports ofmultiple cameras frommultiple servers

• Fixed issuewith opening very longWSB exports split acrossmultiple files

• Fixed issuewhere PTZ Lamps,Washers, andWiperswould not latch on
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29 Version 6.8.22 Changes

29.1 Server Changes
• Support for virtualmachines via hardware dongle

• Support for network licences

• New facilities for copyingdata betweendisks andWavestores (currently advanced feature for use
only guided byWavestore technical support)

• Disk throughput performance improvements

• Improvements to performance of logging facilities

• Option to reverse PTZ tilt operations

• Camera Database Update: Motion recording using ONVIF Pullpoint from Samsung SNV-6013
camera reported to stopworking after server upgrade fromV6.4 to V6.6

• Various failover improvements

• Improved handling of LSIMegaRAID cards

• Fixed issuewith switching off output of AXIS P8221 device

• Improved tools for slewing server clock when incorrect time is set up but recordings need to be
preserved

• Fixed issuewhich could cause log partition on server to fill up

• Fixed issuewhich could cause events to be triggered toomany times

29.2 WaveView Changes
• Several improvements tomain screen Device Tree including...

– Ability to search/filter items in the tree

– Folded/unfolded states of servers and cameras are remembered

– Settings are stored in local preferences so remembered each timeWaveView runs

– Ability to expand all or collapse all items

– Performance improvementswhen connecting to large server groups

• Upgraded to latest Ampleye SDK

73



• Improved UI for setting dewarped views (Oncam and Immervision)

• Local preference to hide ”connect to server group” checkbox

• Change Password tool nowwarns if current server is in group but not connected to group

• New setup option to reverse PTZ tilt operation

• Newhandling for server failover status codes

• Upgrade Bundles now checked before performing upgrades andwarning issued if expired

• Significant performance improvementswhen connecting to large server groups andwhen read-
ing andwriting configuration

• Various improvements to synchronising users in a server group, includingwhen amixture of ver-
sion 5 and version 6 servers

• Fixed issuewhere configuration could report as ”locked”when addingONVIF cameras

• Fixed issuewith ad-hoc dewarping views not being saved in layouts correctly

• Fixed various issueswith non-Latin characters in events and exports

• Fixed graphical issues on systemswith no hardwareOpenGL support

• Variousminor GUI and setup fixes

• Display area no longer solos camerawhen double-clicked, it full-screens instead
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30 Version 6.6 Changes

30.1 Server Changes
• Support formanymore event cause types - see NewEvent Cause Types formore information.

• EVENTX command - supportmore event types

• Server event system support for ONVIF Topic string parameters

• Changes to Live Event Stream revamp to support new types

• New ”CopyTrack” functionality to allow recordings to bemoved between storage devices

• SupportMotion Search (Smart Search)

• New ”TCP-out” I/O protocol, providing support for new3rd party integrations

• Various improvements to support a range of newDell hardware

• New configurable connection timeout

• Added support formore bonded network interfaces

• Added support for Supermicro AOC-SAS2LP-MV8 disk controller

• Added support for various newSupermicro boards

• Fixed issuewith Pelco encoderwhere channelswouldn’t restore after video loss

• Fixed issuewith Uniview cameras including Pullpoint problems andONVIFStreaming over HTTP
when port not 80

• Fixed Video Loss issuewithMobotix cameras

• Fixed issuewith camera host names notworking correctly

• Various other fixes and improvements

30.2 WaveView Changes
• NewMotion Search function in Find screen

• Add support for new customevent causes in event rules setup page

• Updated live event stream to support new event types

• New configurable connection timeout
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• Newoption to restrict ”install” login IP address range

• Upgraded to latest OncamSDK

• Improved audio synchronisation

• Various improvements to integrationmodule selection and parameter entry

• Various fixes relating to saving dewarp views and exports

• Newprogress percentage output on the status bar for CopyTrack operations

• Fixed issuewhere sometimes the clientwould flash/flickerwhite in the Find screen

• Fixed issue where playback of recorded footage on a camera configured for dewarping appears
jerky sometimes

• Fixed issuewith ”image authentication” failing for audio channels

• Several fixes in I/O device setup screen relating to integrationmodules

• Fixed issuesconfiguringanaloguespotmonitorsequenceusingStretchVRC7016LXspotoutputs

30.3 More Information

30.3.1 Changes to motion sensitivity sliders
Prior toWaveViewversion6.6 themotiondetection sensitivity sliderwent from0 to255. During thev6.6
development it was determined that the sensitivity did not go low enough. Therefore the new scale is
0 to 1000. The old value of 255 will now display as 1000, but it is actually the same sensitivity. The old
value of 0will nowbe displayed as 745.

30.3.2 New Event Cause Types
TheWavestorenowhasnewEventCause types. Previous the list of available ”EventCauses”wasafixed
list. Now there are two extraways inwhich new event cause typesmay appear.

• AnONVIF IP camera has sent an event of a type not seen previously byWavestore.

• An integrationmodule has been installedwhich defines newEvent Cause types.

Note that well-defined ONVIF event types are already mapped to Wavestore types. For example, the
ONVIF event type for ”Motion” is alreadymapped to theWavestore ”Motion” event cause.

Further information on this is in the latestWavestoreManual.
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31 Version 6.4 Changes

31.1 Server Changes
• Support for interactingwith LSI RAID cards via theWaveViewDisks Setup Screen

• Syslog alarms forMultipleMegaRAID LSI RAID cards

• Software Support Agreements now enforced

• Email scripts nowhandle secure connections (e.g. SSL/TLS)

• Improved NVIDIA driver handling in graphics driver setup

• Added ”uifstats” command for getting network throughput statistics

• Added ”lspci” command as away of listing hardware devices

• Added ”aplay” command as away of listing audio devices

• Improvements to alog command - new ”-a” and ”-d” options

• Support for ONVIF Auxiliary commands

• Support for ONVIF JPEG/RTP Streaming extension

• Installer no longer automatically reboots at end of install process

• Automatic hardware configuration nowwrites a logmessagewhen run

• Support for operating systemdisks greater than 2 TeraBytes

• Notification protocol: Protocol Dwith time and timezone

• Disabled auto-carving for 3Ware cards since version 6 supportsmuch higher storage capacity

• Added facility for deleting exports inmaintmenuwhen desktop not available

• Fixed issuewith ONVIF RTSP/HTTP reconnections after network outage

• Fixed issuewhereONVIF UDP could not be correctly configured

• Fixed issuewhereONVIF Pullpoint streamswouldn’t always reconnect automatically

• Fixed issuewhereWaveView player not includedwhen footage exported using local client

• Fixed issuewhere ”User agent” string said ”Wavestore/5.0” (ONVIF over HTTP)

• Fixed issuewhereWavestore home page claimed to be version 5
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• Fixed issuewhere the recording indicatorwould flashwhen viewing a camera livewith RTSPdual
streaming

• Fixed issueswith log file rotation

• Fixed issuewhere xrandr tool could not be run

• Update kernel to providemitigation of ”dirty cow” vulnerability

• Security improvements

31.2 WaveView Changes
• Support for interactingwith LSI RAID cards via theWaveViewDisks Setup Screen

• Major rewrite of display area and layout system including:

– Ability to switch video items between slots in a grid layout

– Ability tosavemoresettingswith layoutssuchas ”preserveaspect ratio”, ”contoursandtrack-
ing”, and ”show subtitles”

– Ability to save resolution high/low for each display

– Ability to save audiomode setting for each item in the layout (Mute / Enable / Solo)

– Significant improvements to undo/redo operations for layouts

– Fixed issuewith automatic layout loading at login

– Fixed issuewhere cameraswould always switch to livewhen returning from full-screen

• Server field in login dialog is now auto-populatedwith ”localhost” on first boot after install

• Access toONVIFDevicesmenu nowdenied for lower level users

• Experimental support for hardware accelerated decoding via NVIDIACUDA

• Fixed issue where sometimes dewarped and panorama virtual camera presets weren’t saved in
the right position - see Newdewarping serialisation format formore information.

• Fixed issuewhere server and cameras could be listed twicewhen openingWSB files

• Fixed autologin function for Linux client on server

• Fixed issuewhere files could not be deleted inWaveView filemanager

31.3 More Information

31.3.1 New dewarping serialisation format
Prior toWaveView version 6.4 therewere 4 different techniques for serialisation of dewarping settings:

• Wavestore V5 serialization

• Wavestore V6 serialization

• Oncam serialization
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• Immervision serialization

Investigations during the development of version 6.4 discovered a flaw in the Wavestore serialization
techniqueswhereby they could lose some information, resulting in saved dewarping views sometimes
being saved incorrectly.

Consequently from version 6.4 a new serialization technique ”V6_2” has been introducedwhereby the
values are saved correctly.

These serialization techniques have a number used to differentiate them. Wavestore v5 uses 0, Wave-
store v6uses 1 andsoon. Thisnumber is thefirst number seen in thevenusconfigfileunderCamera_X-
>Lens where the number is recorded in hexadecimal. So for example, if the view is recorded with V6
serialization the datawould beginwith 01XXXXXXXXX...

WhenWaveView is under version 6.4 no views recordedwith the ”V6_2” serialization canbe seen, as the
software doesn’t recognize the number under Camera_X->Lens.

One drawback here is that if the user tries to add views on a camera that already uses ”V6_2” technique
it will have a blackwindowwhen clicking on the ”dewarped” or ”panoramic” buttons.

To fix this issue there are twopossiblework-arounds. The former (and recommended) is to download a
WaveView version >= 6.4, the latter is to click on ”Use Dewarping Options” to disable it, save and set new
views. However thiswill have theconsequenceof removingall viewssetwith thenewserialization tech-
nique.

31.3.2 New layout format
Inversion6.4 itwasdecided thatmany improvementswouldbemade to theway that layouts are saved
and loaded in order tomake the featuremore reliable aswell as to addmore functionality.

Unfortunately it was not possible to maintain backwards compatibility so layouts created with version
6.2 and earlier are not viewable in version 6.4. Similarly, layouts created in version 6.4 are not viewable in
version 6.2 and earlier. Going forward however, the new layout system should be forwards and back-
wards compatible from version 6.4 onwards.
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32 Version 6.2 Changes

32.1 Server Changes
• Support for Dual Streaming from supportedONVIF IP cameras

• NewAutoCamera Setup for support ONVIF IP cameras

• Ability to loadmetadata protocol from file

• Integrationmodules now licence checked

• Improvement to sensormonitoring, supports IPMIand lm_sensorsback-ends, better configura-
bility

• Support for SES external disk enclosuremonitoring

• SystemDrive SMART parameters nowmonitored

• Failover: ForceFail option formaintenance

• Integrationof LSIRAIDcardsviaWavestore interfaceandstorcli, includingsyslogalarmsandhot-
swap

• New ”clear-fault” exec script

• Added new ”Backup” capture type

• CorrectedONVIF identity string

• Various security improvements and bug fixes

32.2 WaveView Changes
• Integrationmodule functions selectable fromdropdown list

• Integration of OncamDewarping SDK.

• Integration of Immervision Dewarping SDK.

• Facility to upload audio files to server for playback on event

• Setup screens for network configuration of ONVIF devices

• Setup screens for ONVIF dual-streaming

• Support for dual-streaming resolution selection
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• Newmethod for adding capture devices including improvements for addingONVIF cameras

• Various terms renamed tomatch industry standards

• Some improvements to layout handling

• Many improvements to I/ODevices Setup screen

• Positions of ’AddColumn’ and ’Add Row’ buttons on Video Display Toolbar are fixed

• Enable/disable audio input and output inWaveView

• Upgraded Ampleye SDK

• New Linux software repositories for v6WaveView on RedHat and Ubuntu systems

• Various security improvements and bug fixes

32.3 Known Issues
• There is an issuewith the ”undo layout” operationwhere it can need to be performed twice to ac-
tually perform the operation. This is due to be addressed in version 6.4.
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33 Version 6.0 Changes vs Version 5

33.1 Server Changes
• Majorupdate tobaseoperatingsystemprovidingbetterhardwarecompatibility, performance, and
more.

• Major update to the LASS filesystem. See section 34.4.3 - .

• N+1 failover support. See section?? -??.

• NFS support in server (newDiskNames syntax).

• LASS6: disk nfs/cifs support inmultiple files.

• Support for up to 32 network interfaces.

• NewAlarmBoard support (Axis VAPIX).

• Support for IPMI sensors to be inspected via SNMP.

• Support formultiple instances ofWaveView client to be run, one per connectedmonitor.

• Identify Faulty Hard Drive.

• Various security updates including...

– SSHprocedure changed.

– DVRSecurity: Privilege separation.

– Config file transmission now encrypted.

– Dropped support for old protocols for security reasons.

– No need to run as root.

– PASSWORD: password algorithmwith ”work-factor”.

– All users are forced to change password on first login.

• The installer now works from USB and has a more intelligent mechanism for determining which
disk the operating system should be installed to. See section 34.4.3 - .

• Multiple log files - EXEC command.

• Newmechanism for identifying audio devices.

• Support for opaque script files.
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33.2 WaveView Changes
• Major user interface update including...

– Updated icons and graphics.

– Dockable components in themain screen.

– Improved configurability of the live event streamwindow.

• New automatic login option.

• Newoption for automatic opening of layout upon login.

• Newoption for automatic full-screen on login.

• NewPassword Policy system.

• Arbitrary camera orientation/ wall angle for dewarping.

• New setup screen for LDAP/Active Directory.

• New setup screen for Failover. See section?? -??.

• Many improvements to I/ODevicesSetupScreen including ability to configure outputs via VAPIX.

• Improvements to Network setup screen including support for network port bonding and jumbo
frames.

• Improvements to Disks setup screen including ability to identify faulty hard drive.

• Support for InputSelect option for selecting analogue audio device input (e.g. Line orMic).

• Newshortcut foropeningcamerasviakeyboardnumpad(holdCtrl, thenpress ”/” followedbycam-
era number, then numpad Enter).

• Local settings now stored to file (”%USERPROFILE%\AppData\Roaming\Wavestore” on Windows,
”~/.config/Wavestore” on Linux).

33.3 Known Issues
• There is no publicly available Ubuntu client for 6.0.

• LASS volume usage percentage is not currently available in version 6 via the Disks Setup screen.

83



34 Important Upgrade Considerations

34.1 Important Information About Upgrading, Licensing,
and Upgrade Bundles

Wavestore uses a system called Upgrade Bundles to allow flexible purchasing of software upgrades.
This system is enforced as of version 6.12.

During theupgradeprocess, users of particularly old versionsof theWavestore server andnewversions
ofWaveViewmay see awarning stating...

Warning: You appear to be upgrading to a software version which is later than your
Upgrade Bundles permit. If you continue with the upgrade the system may become
unlicensed. Do you want to proceed?

Ifupgrading toversion6.10orearlier, thiswill notbean issue. However if upgrading toversion6.12or later,
it is important to check your Upgrade Bundle version before upgrading. This is displayed on the Server
screen ofSetup→ Devices as ”Upgrades to:”. For example:

In this case the latest versionwhich can be upgraded to 6.24. If an attempt ismade to upgrade the unit
to 6.26 or later, and the warning is ignored, the system will no longer be licensed after the upgrade is
completed.

To prevent this happening, please do not proceedwith the upgrade and contact your supplier to obtain
an Upgrade Bundle.

When upgrading the software, recordings are preserved. However it is important to note that the soft-
ware is being continually improved and these improvements might mean that recorded data is not al-
waysbackwardscompatible. So for examplea storagedevice formatted forV6.14mightnotbe readable
if the system is downgraded to V6.10, but it will always be forwards compatible so you can upgrade to a
later versionwithout needing to be reformatted.
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34.2 Considerations For Upgrade From V6.32 And Earlier
to V6.34 Or Later

When upgrading from version 6.32 or earlier to version 6.34 or later, you will only be able to downgrade
to version 6.34. It is not possible to downgrade to version 6.32 or earlier.

If there isadesperateneedtodowngradetoversion6.32orearlier, itwill benecessary to re-install afresh.

For that reason, it is strongly recommended to backup the configuration file of eachWavestore before
performing the upgrade (see section 34.2.2 - Backing UpConfiguration Files).

Also, if the ”annotations” feature is in use, these should also be backed up (see section 34.2.3 - Backing
Up Annotations).

34.2.1 Potential Issues After Upgrade
After upgrading from v6.32 or earlier to v6.34 or later, some issuesmay occur in certain circumstances.
These are documented below, alongwith instructions on how to resolve them.

Disks Missing

If the System Log is reporting ”Missing disk”, that is likely due to the operating system having changed
theway the disks are labelled.

To resolve this:

• Login to the serverwithWaveView

• Go to Tools > Execute Command...

• Ensure thecorrect server is selected fromthedrop-down list in the top-leftcorner of theExecute
Command window

• Run the command ”upgrade-disks”

• Reboot the server

Errors relating to Stretch capture card

Such errorsmay occur on the first boot after upgrading. Simply reboot and the system should function
correctly afterwards.

No user interface when using NVIDIA graphics card

This issue may occur on the first boot after upgrading. Simply reboot and the system should function
correctly afterwards.

34.2.2 Backing Up Configuration Files
The configuration file for a server can be exported usingWaveView as follows:

• Go toView > Setup > Server > Configuration Editor

• ClickSave To File
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• Choose the file location and filename

• ClickSave

If there are other servers in the server group, choose them using the drop-down at the top-left and
repeat the process.

34.2.3 Backing Up Annotations
Annotations can be backed up using theExecute Command function ofWaveView, as follows:

• Go to Tools > Execute Command...

• Run the command ”save-annotations”

• Repeat for all servers in the group by selecting each server in the drop-down list at the top-right
of the Execute Command window

• Close the Execute Command window

• Go to Tools > File Manager...

• For each server in the server group, expand the server name, and it’smisc sub-folder, then select
the ”annotations.zip” file.

• ClickDownload...

If theannotationsneedtoberestored later, simplyUploadthemtothesame locationastheyweredown-
loaded from, using theFileManager. Be sure toupload thecorrect annotations file to thecorrect server.
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34.3 Considerations for Upgrade From Earlier Wavestore
V6 Releases

34.3.1 New Storage System Format (Sub3 and MTable4)
Twonewfilesystemenhancements have been introduced into theWavestore LASS filesystemover re-
cent releases. There are potential issueswith downgrading after using these enhancements so it is im-
portant to read this section.

The first enhancement is calledSub3, an improvement on the earlier Sub2. Sub3provides the following
improvements:

• Improved disk read/write performance

• Larger number of images per disk volume

• More efficient usage of disk space

The second is called MTable4, an improvement on the earlier MTable3. MTable4 provides the following
improvements:

• Disk read/write performance improvements

• Support formore tracks per disk volume

These changes have been introduced over several different versions. TheMTable4 changes are depen-
dent on the version used to format the disks. The Sub3 changes are dependent on the version being
usedwhilst recording, nomatterwhich versionwas used to format.

Compatibility is as follows:

• Version6 releasesprior to v6.24canonly readandwriteSub2andMTable3. Formattingdisksuses
MTable3.

• Version6.24can readSub2orSub3. ItwritesSub2. It canonly readorwriteMTable3. Formatting
disks usesMTable3.

• Version 6.26 can read Sub2 or Sub3. It writes Sub3. It can read or write MTable3 or MTable4.
Formatting disks usesMTable3.

• Version 6.30 introduces support for recordingMTable4 by default. This version can read Sub2 or
Sub3, and itwritesSub3. It can readorwriteMTable3orMTable4. FormattingdisksusesMTable4.

For this reason, it is important to consider that if the systemwere upgraded to a later version and then
downgraded, some recordingsmay no longer be readable. For example, if a v6.18 is upgraded to v6.26,
it will start recordingwith Sub3. If it is then downgraded back to v6.18, the Sub3 recordingswill not be
visible. If it is upgraded to v6.26 again, all the recordingswill be visible again.

Similarly, if a system is installed with v6.30 and the disks are formatted, if it is downgraded to v6.24 or
earlier, the datawill not be readable orwriteable until the disks are reformatted.

34.3.2 New Event Rules System
Amajorchange inversion6.20onwards is the introductionof thenewEventRulessystem. It’s important
to be aware that the old and new event rules engines are not compatible. When a Wavestore server is
upgraded to version6.20or later andhas existing event rules, those ruleswill continue towork asbefore
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and theEventRulessetupscreenwill show”Using legacyEventRulesmode” at the top. Thebehaviourof
the event systemwill be the sameas before. To enable usage of the newenginewith all its new features
it is necessary to remove all existing event rules, then exit the Event Rules screen and re-enter it.

ThenewEventRules system is fully documented in theproductmanual. However some likelyquestions
about the new system are answered below.

What happened to the old ”Show onmain screen” function?

In the new Event Rules engine, there is no ”Show onmain screen” checkbox for an event rule, as there
was with older versions. The new engine requires you to add a Cause of type ”Manual Trigger”, with an
ID, to the rule.

Forexample, in theoldsystemyoumightconfigurea rulewhichsays ”Motiononcamera3” triggers ”Out-
put 5”.

In the new systemyouwould configure the rule to say ”Motion on camera 3” OR ”Manual Trigger 1” trig-
gers ”Output 5”.

The Events panel on themain screenwill show the rule name for any ruleswhich have amanual trigger,
and activating that rulewill trigger the ”Manual Trigger” causewith the associated ID.

What happened to the ”Enable logging” function?

In the new engine, there is no ”Enable logging” checkbox for an event rule, as there waswith older ver-
sions. When using the new engine, all event logs arewritten to a new ”Event” log automatically. You can
access this log by running ”alog Event” via the Execute Command tool. In a future client version, the
System Log viewerwill allow browsing these logs.

What happened to the Schedule setting for a rule?

In the new engine, Schedule is an Event Cause of its own, allowing powerful rules to be built. In simple
terms youwould normally just do an AND logical operationwith an existing Event Cause.

For example, youmight configure the rulewith causes: ”Motion on camera 3” AND ”Schedule 1”, and ac-
tions: ”Output5”. Thiswouldmean itwill triggeroutput5whenthere ismotiononcamera3andschedule
1 is On.

34.3.3 Important Information about New Configuration Format
One of the main focal points of version 6.14 was to simplify ease-of-setup. This has been achieved by
introducing several new features including Camera Groups and the ”Auto” group type which will try to
automatically detect the camera type and set it upwith sensible defaultswithout requiringmanual set-
tings.

One effect of these changes is that the configuration format written by WaveView version 6.14 is new,
and therefore cannot be understood by old versions of theWavestore client software, includingWave-
View, WaveSDK-ActiveX, and WaveView Mobile. Therefore any client devices needing to access a
v6.14 server configured with these new facilities need to be up-to-date. If using the on-server client
display, this does not restart automatically, so a reboot is recommended.

Thenewversion 1.14WaveViewMobile clientwill be required for any servers configuredwith 6.14. How-
ever it’s important tonote that this versiondoesnot supportAndroid4.4.4 (KitKat) orbelow. Android5.0+
is required. This is due to themanufacturer dropping support for these older versions.
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Also note that exports are backwards compatible but not forwards compatible, meaning that exports
made in v6.14 can’t be played back in older WaveView versions, but exports made in older WaveView
versions can be played by v6.14.

Theversion6.14client iscompatiblewithserversas farbackasversion5.54andcanbeusedtoconfigure
those servers, however someof thenewsetupconveniences such as ”Auto”modeandCameraGroups
may not be available.

Upon upgrading to version 6.14, the server automatically makes a backup of the configuration. Should
anything gowrong, this backup can be quickly restored by going to View → Setup → Server → Con-
figuration Editor→ Load Backup.

Whenaserver is upgraded toversion6.14, the server’s configuration is not changedautomatically. How-
ever the first timeav6.14client is used tomakechanges in theCameras setupscreen, these settingswill
bewritten back in the new format.

Note that the default recording setting in version 6.14 is to record for an absolutemaximumof the spec-
ified days. Previously the default behaviour was to record for as long as possible, using the configured
days as a guideline of how to balance the available space between the various recording tracks. It is
important to check that these newdefault settings are desirable and change them if not.

To summarise these points:

• Version 6.14 can read andwrite to any server version back as far as version 5.54.

• If using v6.14 or later, any settings made in the Cameras setup screen will be in the new format,
which can’t be understood by older client versions.

• Exportsmadebyv6.14afterupdatingto thenewconfiguration formatcan’tbe readbyolderWave-
View clients.

• Upon upgrading to v6.14, the configuration is automatically backed up to allow rolling back if nec-
essary.

• The newWaveViewMobile only supports Android v5.0 and later.

• If using the on-server client display, a reboot is recommended.

• Thedefault recordingsetting inversion6.14 isnowtorecord foranabsolutemaximumof thespec-
ified days.
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34.4 Considerations for Migrating From Wavestore V5
• Themigration process requires a fresh installation of the Version 6 software on to theWavestore
server. This requires physical access to theWavestoreand cannot be performed remotely.

• In general, all recordingswill be preserved. The exception is that any recordings on the operating
systemdiskwill be lost (this is normally configured as Disk D by default).

• All annotationswill be lostwhenmigrating fromVersion 5 to Version 6.

• Support for some older analogue capture devices has been discontinued. See section 34.4.2 -
Hardware Support.

• It is advisable to upgrade all remote client software first since the Version 6 clients are compatible
with existingVersion5 servers. See section34.4.1 -Compatibility BetweenVersion5 and6Client
and Servers.

• It is advisable to test the client software on any remote client PCs before attempting the migra-
tion. The method by which WaveView renders video to the display has changed and therefore it
is possible that some client PCs which previously worked with Version 5might have issues with
Version 6. If testing uncovers any issues, please obtain a system report from theWaveView ”Help
| About | System Info” screen and contact our support teamwith details.

• When importing a configuration file from a Version 5 server, the network settings will be invalid
and will need to be re-entered manually. If you accidentally import the configuration including
the network settings, simply use the Advanced Configuration Editor to delete the [Network_X]
sections, reboot, then re-enter the network configurationmanually.

34.4.1 Compatibility Between Version 5 and 6 Client and Servers
Note that in this section, ”client” means viewing software such asWaveView,WaveViewMobile, and the
WaveSDK-Active SDK. ”Server”means theWavestore Recorder.

• Version6client software is fully compatiblewithVersion5Wavestoreservers runningversion5.44
or later.

• Version5.54client softwareand later is partially compatiblewithVersion6Wavestore servers. The
limitations are:

– It is not possible to configure a Version 6 server, so the Setupmenu option is disabled.

– It is not possible to save layouts.

– It is not possible to save dewarped views.

• Version 5.52 and earlier of the client software is not compatiblewith Version 6 servers.

34.4.2 Hardware Support
The following older generations ofWavestore compatible analogue capture devices are no longer sup-
ported:

• TheWavelet Serial Multiplexer

• TheMach series
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• TheWarp series

• The Stretch S6 series

Note that you can checkwhich analogue capture cards you have by accessing the server usingWave-
View and going to Setup|Devices, then clicking on the appropriate capture device in the device tree on
the left. The Stretch S6 series have a ”Subtype” beginningwith ”VRC6”.

34.4.3 Major New Features and Changes

New LASS Filesystem

Version 6 has a new filesystemwhich provides many benefits over the Version 5 equivalent. If you are
migrating fromVersion5, existing recordingswill be preserved, however thebenefits of thenewfilesys-
tem are not available. The benefits of the new filesystem are only available if you format your storage
whilst running Version 6.

Here are some of the benefits of the new LASS filesystem in Version 6:

• Support for very large volumes...

– Up to 26 volumes perWavestore - where a volume is usually a disk, a partition on a disk, or a
RAID array ofmultiple disks.

– Up to 16 trillion images per volume - that’s approximately 7.4 million days at 25 images per
second, or the equivalent of 254 cameras for 80 years at 25 images per second! TheVersion
5 limit was 589million images.

– Approximately 16 PetaBytes per volume. Version 5 limit was 20 TebiBytes (Note: a TebiByte
is approximately 1.1 TeraBytes).

– 512 recording tracks per volume. Version 5 limit was 128.

• Improved disk performance

Software Installer Changes

The software installer nowworks fromUSB. Previously it was necessary to burn the ISO to a DVD.

The installer now has amore intelligentmechanism for determiningwhich disk to install to. It will install
to the smallest device which is greater than 26GB and not the device which the installer is on. i.e. 16GB
deviceswill be ignored, 32GBwill potentially be used.

Instructions for re-installing theWavestore software are in the fullmanualwhich is providedon theDVD
or ISO file.

Licensing Changes

• NewBASE licence providesmaximum2 simultaneous users.

• Active Directory support is now licence controlled.

• Integrationmodules are now individually licensed.
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35 Upgrade Process

The Upgrade Setup Screen (menu pathView→ Setup→ Upgrade) allows theWavestore server soft-
ware to be upgraded to the latest version.

Note: Upgradeswill be applied to all connected servers in the server group and can be carried out from
a networked PC or laptop, or on the server itself.

If upgrading from a remote PC, it is recommended to update the WaveView software on that PC first,
before upgrading the servers.

There are twomethods of upgrading the system to a new version:

File Upgrade
The systemwill be upgraded using an ISO filewhich has been downloaded. No internet connec-
tion is required.

Network Upgrade
The systemwill download updates from the internet. Therefore, the Wavestore servers must be
connected to the internet.

35.1 Performing a File Upgrade
To upgrade from an ISO file, the ISO first needs to be ”mounted” or written to a USB memory stick or
DVD. If the ISO is on a Windows PC, the easiest method is simply to mount the ISO. This is done by
right-clicking the ISOfile and choosing ”Mount”. The ISO is then available as a separate disk (e.g. ”F:”), as
if a pre-written USB stick or DVD had been inserted.

If it is necessary to upgrade theWavestore by connecting to it directly rather than from a remote client
PC, itwill be necessary towrite the ISOfile to aUSBmemory stick orDVD.OnWindowswe recommend
the use of a program called Rufus. See section 35.4 -Writing an ISOwith Rufus.

Before performing the upgrade, navigate to the Server setup screen (View→ Setup→ Server) and in-
spect the ”Distribution” field. This is displayed on the ”General” tabwhich is the default.

If the distribution contains ”el7” rather than ”el7a” it is recommended to perform the upgrade twice. The
first upgradewill update theWavestore software but not the operating system. The secondwill update
the operating system. This is only ever necessary once. Subsequent upgradeswill only need to be per-
formed once.

If in doubt, performing the upgrade twice is sensible. If there is nothing to upgrade on the second pass
it will complete very quickly.
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Figure 35.1: Upgrade Server Screen

To perform the upgrade, first browse to the location of the upgrade file (’upgrade.txt’).
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Figure 35.2: Upgrade Server screen – browsing to locate ’upgrade.txt’ file

Once you have located the ’upgrade.txt’ file, select it then click on ’Open’.

TheSelect Upgrade File fieldwill now show the upgrade file that you have chosen.

If performing a downgrade, ensure the ”Enable downgrading” checkbox is checked. Only enable this
checkbox if deliberately downgrading to an earlier version.

Click on ’Upgrade’, and the Informationwindowwill showprogress of the upgrade, as the upgrade files
are copied across to the server:
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Figure 35.3: Upgrade Server screen – upgrade files being copied to the server

Once all the files have been checked and copied, the upgrade processwill start. The systemwill tell you
towait and thismay take a fewminutes.

Whilst the upgrade takesplace, recording continues. However once theupgrade is complete, the server
will either do a software restart or a reboot, depending on what is necessary to complete the upgrade.
Obviously recording is interrupted briefly at this time. Downgradeswill always perform a reboot.
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Figure 35.4: Upgrade Server screen – upgrade completed

35.2 Performing a Network Upgrade
Servers running version 6.38 or later can be upgraded over the internet. Each server in the server group
will need to be connected to the internet.

Note: If any server in the server group does not support network upgrades, network upgrades will be
disabled for thewholegroup. In thatcase itwill benecessary to log in toeachserver (whichdoessupport
network upgrades), and perform the upgrade individually.
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To perform a network upgrade, enter the version to which the servers should be upgraded in the ’Up-
grades To’ text box, for example ’6.38’, then click ’Upgrade’.

The process performed by each server is:

• Check that the requested upgrade version is available

• Download the packages (i.e. components) for the upgrade

• Install the packages
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The progress of the upgradewill be reported in the ’Information’ panel.

35.3 Potential Issues
If the upgrade fails, it will usually either show a failure message in the Upgrade screen, or a message
saying ”the upgrade completedwithout sending a status reply”.

In this case, gatheringmore information depends on the currently running version.

For servers running version 6.24 or later, this information is available inWaveViewby navigating to Tools
→ System Log, clicking the ’Extra Logs’ tab, then choosing ’Upgrade’ from the drop-down box, then
clicking ’Download’.

For servers running version 6.16 or later, a more detailed log of the upgrade is available by following this
procedure:

• Select Tools→ Execute Command...

• Run the command alog -a Upgrade

• Send this output to our support team for assistance
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For servers running version 6.14 or earlier, the information is in the system log, available inWaveView by
navigating to Tools→ System Log.

The possible errors are listed belowwith an explanation ofwhat to do:

Upgrade failed: installing package XXX needs nMB on the / filesystem

Certain upgrades such as to v6.16 require a large amount of temporary space on the operating system
diskand thoseoriginally installedwithanearly versionofWavestore (version6.10orearlier)maynothave
enough space to complete a full upgrade.

Itmaybepossible to free up space on the systemusing the filemanager although this requires physical
access to the server. Using the client display on the server itself, move the mouse to the top-left of the
screen and a toolbar should drop down. Choose the icon which resembles a filing cabinet. If there are
any large files in there, deleting themmay free up enough space to complete the upgrade.

If the above stepsdonotwork, itmaynot bepossible toperform theoperating systemupgradewithout
a re-installation. Re-installation requires being on-site andusually takes around20minutes. Performing
the re-installation creates a larger partition so that future upgrades do not have this issue.

SSDwearing out too fast

Thismessagemay appear in the log because some upgrades perform a large amount of writing to the
operatingsystemdisk. Unlessyouaregoing todoa full systemupgradeeveryweek, this is not aconcern
and can be ignored, and the SSDwill still last formany years.

Note that the message is a check on rate of wear, not an indication it is worn out. If you want to see
howmuch life left (in percentage terms), in WaveView go to Tools → Execute Command and run the
command ”ssd”.

35.4 Writing an ISO with Rufus
To install or upgradeWavestore from a USBmemory stick it is necessary to extract the ISO to the USB
stick. ThewaytodothisdependsontheOperatingSystem. MostcommonlyMicrosoftWindows isused,
inwhich case the Rufus program is recommended.

Assuming the installation ISO has already been obtained, the process is as follows:

• OnWindows, download Rufus from http://rufus.akeo.ie

• Run Rufus.

• Plug in the USB stick. Rufus should recognise the USB and populate the ”Device” box.

• On Rufus: ”Format Options”/”Create a bootable disk using” and select ”ISO Image”.

• On Rufus: click the icon to the right of the above text and select the ISO.

• On Rufus: click [Start] to start thewrite to USB.

• Select ”Write in ISO Imagemode (recommended)” and click OK if Rufus asks about deleting files
on the USB stick.
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• It’ll take a fewminutes to create the bootable USB.
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